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3.02 
Plan Review Process – Detailed Plans 

 

All projects requiring detailed plans shall be submitted to the appropriate Delegated 
Agency utilizing a 3-step process as outlined below.  Applicants are expected to gain 
approval at each step prior to submission for the next step.  The application package 
for each step shall be reviewed for completeness by the Delegated Agency in 
accordance with the appropriate checklist.  Any application deemed incomplete shall 
be returned to the applicant with an explanation of the missing material.  The 
Delegated Agency will only be responsible for the review of complete applications.   
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3.02.1 
Step 1:  Project Application Meeting 
 
The Sediment and Stormwater Program requires a Project Application Meeting for all 
proposed land disturbing activities that will require a detailed Sediment & Stormwater 
Plan approval.  These meetings are structured to assist the owner, developer, and 
designer in the design process, and to provide early notification of approval 
requirements.   
 
Prior to scheduling the required meeting, the applicant must submit a Stormwater 
Assessment Study (SAS) and the completed SAS Checklist to the appropriate 
Delegated Agency. The Stormwater Assessment Study Checklist is available in 
Appendix 3.02.1.1.  Incomplete submittals will be returned in whole with the missing 
checklist items highlighted.  
 
Responsibilities for the various elements of the project application meeting shall be as 
follows: 
 Applicant 

1. Provide contact information for both owner/developer and consultant. 
2. Submit Stormwater Assessment Study (SAS) and completed SAS checklist.  

 Delegated Agency 
1. Review SAS submittal for completeness and schedule the project application 

meeting with all necessary parties. 
2. Ensure all relevant topics are discussed and/or addressed during the project 

application meeting. 
3. Forward Stormwater Assessment Report (SAR) to appropriate land use planning 

agency. 
Project application meetings will be scheduled within 2 weeks of a complete submittal.  
Not more than one hour will be allotted for the meeting for a single project. 

Items discussed during the meeting shall be documented on the Sediment & 
Stormwater Program Project Application Meeting Discussion and Agreement Items 
form.  All attendees shall sign this form at the conclusion of the meeting.  An example 
Sediment & Stormwater Program Project Application Meeting Discussion and 
Agreement Items form is included as Appendix 3.02.1.2. 

Copies of the Stormwater Assessment Report shall be provided to the applicant as well 
as to the appropriate local planning agency.  The Stormwater Assessment Report is 
located in Appendix 3.02.1.3.  

An example Project Application Package is included as Appendix 3.02.1.5. 



 
   

Office Use Only     
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Stormwater Assessment Study (SAS) Checklist 
 

 
Project Name:                               
 
 
Owner/Developer Name:          
 
    Contact Person:          
 
Owner/Developer Phone:          
 
Owner/Developer e-mail:          
 
 
Consultant Name:           
 
   Contact Person:           
 
Consultant Phone:           
 
Consultant e-mail:           

This checklist is for guidance only.  The Delegated Agency reserves the right to request 
additional information during the review process as it deems necessary. Compliance with the 
checklist in no way is meant to relieve the design professional of his/her professional 
responsibilities. 
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A. Documents 

Items shall be arranged in the following order: 

� Completed Stormwater Assessment Study  (SAS) Checklist 

� Narrative of existing site conditions including information on existing 
downstream conveyance and Points of Analysis (POAs)  

 Identify existing structures 

 Describe condition of existing structures / channels / outfalls 

 Provide photographs of structures / channels / outfalls / POAs 

� Narrative of proposed development project type and description 

 Residential 

 Commercial/Institutional 

 High/Low Density 

� Feedback from DelDOT Maintenance regarding drainage concerns. 

Consultant will contact DelDOT, providing a description of the project 
location, including road name and project location from the nearest 
intersection.  Parcel ID number should also be provided.  DelDOT will 
respond with any known drainage and flooding problems. 

• New Castle County – (302) 326-4523 

• Kent County – (302) 760-2424 

• Sussex County – (302) 853-1340 

This checklist is for guidance only.  The Delegated Agency reserves the right to request 
additional information during the review process as it deems necessary. Compliance with the 
checklist in no way is meant to relieve the design professional of his/her professional 
responsibilities. 
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B. On-Line Background Information 

Items shall be arranged in the following order: 

� Stormwater Assessment Study GIS Mapping 
Provide a printout of the site location mapped for each layer represented: 

� Parcel Boundary showing NHD streams and water features 

� Existing 2’ contours 

� Tax ditch watershed boundaries 

� Tax ditch channel locations 

� Tax ditch rights-of-way 

� Wellhead protection areas 

� Aquifer recharge areas 

� Floodways 

� Flood hazard areas 

� 2007 Land Use / Land Cover (LULC) 

� Hydrologic Soil Groups (HSG) 

� State Wetland Mapping Project (SWMP) 

� Runoff Reduction Feasibility (NOTE: much of New Castle County is not mapped) 

 
SAS GIS Web application link: 
http://dnrecgis.maps.arcgis.com/apps/OnePane/basicviewer/index.html?appid=4
e85b5dd93834c669560faa8b338216f 

 

� StreamStats map showing limit of downstream analysis.  (The 
downstream analysis point will be located at the point in the watershed 
where the site area comprises less than 10% of the watershed area.)   
StreamStats link: http://water.usgs.gov/osw/streamstats/delaware.html 
 
 

� StreamStats Basin Characteristics Report 
StreamStats link: http://water.usgs.gov/osw/streamstats/delaware.html 
 

This checklist is for guidance only.  The Delegated Agency reserves the right to request 
additional information during the review process as it deems necessary. Compliance with the 
checklist in no way is meant to relieve the design professional of his/her professional 
responsibilities. 
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� Customized Web Soil Survey reports for Stormwater Management for 

proposed developed area of the site. 
Link: http://websoilsurvey.nrcs.usda.gov/app/WebSoilSurvey.aspx 

 
The following elements are required for submittal: 

SWM Soils Report Elements Map Table Desc. Report 
Soil Map Tab X       
      

 
  

Soil Data Explorer Tab     
 

  
Suitabilities and Limitations for Use     

 
  

Land Classifications     
 

  
Map Unit Hydric Rating X X X   

Water Management     
 

  
Embankments, Dikes and Levees X X X   
Excavated Ponds (Aquifer-Fed) X X X   
Pond Resevoir Area X X X   

Soil Properties and Qualities     
 

  
Soil Erosion Factors     

 
  

K Factor - Whole Soil X X X   
Soil Qualities and Features     

 
  

Drainage Class X X X   
Hydrologic Soil Group X X X   

Water Features     
 

  
Depth to Water Table X X X   
Flooding Frequency Class X X X   
Ponding Frequency Class X X X   

Soil Reports     
 

  
Building Site Development     

 
  

Roads & Streets, Shallow Excavations, Lawns & 
Landscaping     

 
X 

Soil Physical Properties     
 

  
Engineering Properties     

 
X 

Physical Soil Properties       X 
 

 
� If DelDOT conveyance will be used to discharge stormwater from 

proposed development, submit DelDOT Road Plans for background 
information. 
DelDOT Archive link: 
http://www.deldot.gov/information/pubs_forms/archived_plans/index.shtml 

This checklist is for guidance only.  The Delegated Agency reserves the right to request 
additional information during the review process as it deems necessary. Compliance with the 
checklist in no way is meant to relieve the design professional of his/her professional 
responsibilities. 
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C. Existing Hydrology Mapping  
 

Submit an existing drainage features map (1”=100’ scale) showing: 

� flow paths 

� on-site subareas 

� off-site subareas  

� site points of analysis 

 
 
D. Completed Stormwater Assessment Report 
 

Submit a completed Stormwater Assessment Report, including: 

� Assessment Item ratings for anticipated engineering effort 

� Computation sheet used to determine ratings 
 

  
 

This checklist is for guidance only.  The Delegated Agency reserves the right to request 
additional information during the review process as it deems necessary. Compliance with the 
checklist in no way is meant to relieve the design professional of his/her professional 
responsibilities. 
 
03/13/2014 3.02.1.1-5 



Sediment and Stormwater Program Project Application Meeting 
Discussion Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

1. TMDL Watershed:

2. Groundwater Mapping

a. Wellhead Protection Areas:

 YES 
 NO 

b. Depth to Water Table (Wet): __________________________ 

3. Watershed Master Plan

a. Does this site fall within an area served by a watershed master

plan?

 Appoquinimink WS 

 Murderkill WS 

 Upper Nanticoke WS 

 Other: ____________________________________ 

 Not within an area served by a watershed master plan 

b. What special design criteria are set for this project based upon its

location in a watershed having a master plan?
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Sediment and Stormwater Program Project Application Meeting 
Discussion Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

4. Does the site contain tax ditches?

 YES  
 NO (continue to the next item) 

Tax Ditch Name Right-of-way Information 

a. Is there a proposal for changing tax ditch watershed boundaries?

YES 
NO 

b. Does the tax ditch require a court order change (COC) for

development to occur as planned?

YES 
NO 

c. Additional information regarding court order change:
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Sediment and Stormwater Program Project Application Meeting 
Discussion Items 

 
Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

 
5. Proposed grading plan.  

a. Proposed grading plan must not block drainage from offsite areas 

currently draining onto the site.  

i.  Are offsite areas currently draining onto the site?   

 YES  
 NO  

ii. How will offsite areas draining onto the site be managed?   

 Captured in onsite BMPs 

 Bypassed 

b. Disturbed areas greater than 20 acres to any single discharge point 

will require engineered control practices designed for bare earth 

conditions for a 2-YR, 24-HR storm event.   

Proposed disturbed area:         

 

6. The plan areas will be reviewed and approved by the following 

agency(ies):  

a. Onsite areas:          

b. Offsite roadway improvements:        

 

7. Is there a proposal to discharge to a DelDOT, municipal or private 

drainage system? 

 YES – notice of intent to discharge must be provided to 

system owner 

 NO (continue to next item) 
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Sediment and Stormwater Program Project Application Meeting 
Discussion Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

8. Fees - The fees to be submitted to are as follows:

9. The Notice of Intent (NOI) and $195 NOI fee must be submitted to

DNREC prior to Sediment and Stormwater Plan approval, unless one of

the following conditions is met:

� Project site has existing NOI (ID #: ) 

� Project <1.0ac disturbed 

NOI comments: 
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Project:_____________________________________________________

Owner/Developer: ____________________________________________

Consultant:__________________________________________________

Assessment Item

Minor Moderate Significant

1. Soils - On-site soils have low permeability, high water table, or other
limitations that could adversely affect adequate stormwater management
for the proposed project.

  

2. Runoff Potential - Change in land cover due to removal of trees, increases
in impervious cover, etc. could adversely affect adequate stormwater
management for the proposed project.

  

3. Water Resource Protection - Site conditions may adversely affect runoff
reduction and/or pollutant loading reductions.

  

4. Sump Conditions - Existing topography of site creates depressional areas
(closed 2' contours) where runoff tends to collect without direct discharge.

  

5. Discharge Points - Areas where stormwater runoff leaves the site have
limitations due to low gradient, backwater effects, lack of a defined channel
or other hydraulic limitations.

  

6. Off-Site Drainage - Areas draining into the site could adversely affect
adequate stormwater management for the proposed project.

  

7. Conveyance - Downstream conditions such as inadequate pipe or channel
capacity could limit adequate drainage from the site.

  

Mitigation under consideration for “Significant” ratings:
   Over-management
   Off-site improvements
   Easement(s)

   Offset Option

   Other: _______________________________________________

Reporting Agency: ____________________________________________

Contact Person: ______________________________________________

Date of Project-Application Meeting: _____________________________

Anticipated Engineering Effort

Stormwater Assessment Report
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Sediment and Stormwater Program Project Application Meeting 
Agreement Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

1. Review Stormwater Assessment Report (SAR) to be sent to County or

Municipality as a group and come to agreement on individual ratings.

a. Site qualifies for Unit Discharge Approach by having all “Minor”

ratings?

YES  
NO (continue to next item) 

b. For Unit Discharge approach, existing conditions land cover will be

considered as:

Non-Woods/Non-Meadow (ac): _____________________ 

Woods/Meadow (ac):  _____________________ 

Woods/Meadow HSG-A (ac): _____________________ 

Off-site areas (ac):  _____________________ 

2. Points of Analysis (POAs)

a. Onsite points of analysis:

 POAs in accordance with SAS plan submitted 

 POAs modified as follows: 

 New POA(s) added as follows: 

b. Offsite / downstream points of analysis based upon 10% rule:

 POAs in accordance with SAS plan submitted 

 POAs modified as follows: 

 New POA(s) added as follows: 
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Sediment and Stormwater Program Project Application Meeting 
Agreement Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

3. Drainage area boundaries:

 Existing conditions drainage area boundaries in accordance 

with SAS drainage area plan submitted 

 Modified as per project application meeting (see revised plan) 

4. Existing drainage features:

 In accordance with SAS drainage features map as submitted 

 Modified as per project application meeting (see marked-up plan) 

5. Stormwater Quality Management

a. The Delaware Sediment and Stormwater Regulations require that

runoff reduction practices be used to meet the RPv requirements.

The following runoff reduction BMPs are being considered for the

site:

 Proposed BMPs are feasible based upon Feasibility criteria in 

BMP Standards and Specifications 

b. Justification if runoff reduction practices are considered not feasible 

for the site:
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Sediment and Stormwater Program Project Application Meeting 
Agreement Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

c. Indicate section of Regulations for complying with RPv:

5.2.3.1 Runoff reduced to equiv wooded condition 

5.2.3.2 Equivalent 0% effective imperviousness 

5.6.3.1 Redevelopment equiv wooded condition 

5.6.3.2 Redevelopment: 30% reduction in effective 

imperviousness 

d. List any other issues related to compliance with RPv requirements:

6. Stormwater Quantity Management

a. The following BMPs are being considered for stormwater quantity

management for meeting the Cv and Fv requirements:

b. Indicate section of Regulations for complying with Cv:

5.3.3.1 Management for no adverse impact 

5.3.3.2 Tidal Discharge 

5.3.3.3 Watershed Location 

5.3.3.4 De minimus discharge 

Management in accordance with watershed 

management plan 
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Sediment and Stormwater Program Project Application Meeting 
Agreement Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

c. Indicate section of Regulations for complying with Fv:

5.4.3.1 Management for no adverse impact 

5.4.3.2 Tidal Discharge 

5.4.3.3 Watershed Location 

5.4.3.4 De minimus discharge 

Management in accordance with watershed 

management plan 

d. List any other issues related to compliance with the Cv or Fv

requirements.

7. Wetland delineation will be required for the project:

 YES 
 NO 

Comments: 

8. Next submittal step:

 Preliminary Sediment and Stormwater Management Plan (complete 

item 9 below) 

 Combined Preliminary and Sediment and Stormwater Management 

Plan (complete items 9 and 10 below) 

9. Schematic Plans required with Preliminary plan submittal:

 Schematic Pre-Construction Site SWM Plan 

 Schematic Construction Site SWM Plan 

 Schematic Post Construction SWM Plan 
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Sediment and Stormwater Program Project Application Meeting 
Agreement Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

10. Sediment and Stormwater Plan Sheets to be prepared and submitted:

 Coversheet and General Notes 

 Overall Construction Site Phasing Plan 

 Overall Pre-Construction Site Stormwater Management Plan  

 Pre-Construction Site Stormwater Management Plan #X 

 Overall Construction Site Stormwater Management Plan  

 Construction Site Stormwater Management Plan #X 

 Construction Site Details and Notes (including the Sequence of 

Construction) 

 Overall Post Construction Stormwater Management Plan 

 Post Construction Stormwater Management Plan, Facility #X 

 Contributing Drainage Area Plan 

 Pre-Limit of Disturbance Drainage Area Plan 

 Post Limit of Disturbance Drainage Area Plan  
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Sediment and Stormwater Program Project Application Meeting 
Agreement Items 

Project Name: ________________________________________________ 

Meeting Date: ________________________________________________ 

The Preliminary Sediment & Stormwater Plan shall be based upon the discussion 

and agreement items from this Project Application Meeting.  The Delegated 

Agency reserves the right to revisit the agreement items from the original Project 

Application Meeting if the applicant later proposes significant changes to the 

project which would alter the results of the original Stormwater Assessment 

Report (SAR).  Signing below indicates presence and participation at this Project 

Application Meeting for the project identified in this document, as well as 

agreement to the items referenced in this document. 

Printed Name Company/Agency Email address Signature 

11/7/2014 3.02.1.2-11 



7/3/2014 3.02.1.3-1

Project:_____________________________________________________

Owner/Developer: ____________________________________________

Consultant:__________________________________________________

Assessment Item

Minor Moderate Significant

1. Soils - On-site soils have low permeability, high water table, or other 
limitations that could adversely affect adequate stormwater management 
for the proposed project.

  

2. Runoff Potential - Change in land cover due to removal of trees, increases 
in impervious cover, etc. could adversely affect adequate stormwater 
management for the proposed project.

  

3. Water Resource Protection - Site conditions may adversely affect runoff 
reduction and/or pollutant loading reductions.  

  

4. Sump Conditions - Existing topography of site creates depressional areas 
(closed 2' contours) where runoff tends to collect without direct discharge.

  

5. Discharge Points - Areas where stormwater runoff leaves the site have 
limitations due to low gradient, backwater effects, lack of a defined channel 
or other hydraulic limitations.

  

6. Off-Site Drainage - Areas draining into the site could adversely affect 
adequate stormwater management for the proposed project.

  

7. Conveyance - Downstream conditions such as inadequate pipe or channel 
capacity could limit adequate drainage from the site.

  

 Mitigation under consideration for “Significant” ratings:  
       Over-management
       Off-site improvements
       Easement(s)

       Offset Option

       Other: _______________________________________________

Reporting Agency: ____________________________________________

Contact Person: ______________________________________________

Date of Project-Application Meeting: _____________________________

Anticipated Engineering Effort

Stormwater Assessment Report
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Assessment Item
Minor Moderate Significant

1. Soils - On-site soils have low permeability, high water table, or 
other limitations that could adversely affect adequate stormwater 
management for the proposed project.

<15% of developed portion of the site has 
soils with limitations to development 

15% - 50% of developed portion of the site has 
soils with limitations to development 

>50% of developed portion of the site has soils 
with limitations to development 

2. Runoff Potential - Change in land cover due to removal of trees, 
increases in impervious cover, etc. could adversely affect adequate 
stormwater management for the proposed project.

<25% existing woods/meadow                         
to be disturbed                                     

25%-50% existing woods/meadow                   to 
be disturbed

> 50% existing woods/meadow                             
to be disturbed

OR OR OR

<25% proposed increase in impervious area 25%-50% proposed increase in impervious area > 50% proposed increase in impervious area

3. Water Resource Protection - Site conditions may adversely affect 
runoff reduction and/or pollutant loading reductions.  <15% of developed portion of the site has 

RR Feasibility rating of Low or Low-Mod
15% - 50% of developed portion of the site has 

RR Feasibility rating of Low or Low-Mod
>50% of developed portion of the site has RR 

Feasibility rating of Low or Low-Mod

OR OR OR
For areas not mapped for RR Feasibility, 

<15% of developed portion of site                          
has water table <36" (100cm)                          

or HSG "C" or "D" soils

For areas not mapped for RR Feasibility,            
15% - 50% of developed portion                                        

of site has water table <36" (100cm)                                             
or HSG "C" or "D" soils

For areas not mapped for RR Feasibility,             
>50% of developed portion of site                                

has water table <36" (100cm)                                             
or HSG "C" or "D" soils

4. Sump Conditions - Existing topography of site creates depressional 
areas (closed 2' contours) where runoff tends to collect without 
direct discharge.

0% of site area drains to sump areas <50% of site area drains to sump areas >50% of site area drains to sump areas

5. Discharge Points - Areas where stormwater runoff leaves the site 
have limitations due to low gradient, backwater effects, lack of a 
defined channel or other hydraulic limitations.

Zero (0) site discharge points with identified 
problems

At least one (1) site discharge point with an 
identified problem

Multiple (more than 1) discharge point with an 
identified problem

OR OR

< 50% of site area drains to a  discharge point 
with an identified problem

>50% of site area drains to a  discharge point 
with an identified problem

OR
Lack of easements and/or alteration of drainage 

patterns could raise potential "right-to-
discharge" issues.

6. Off-Site Drainage - Areas draining into the site could adversely 
affect adequate stormwater management for the proposed project.

<25% offsite area relative to site area 
draining onto site

25% - 50% offsite area relative to site area 
draining onto site

>50% offsite area relative to site area draining 
onto site

7. Conveyance - Downstream conditions such as inadequate pipe or 
channel capacity could limit adequate drainage from the site. Zero (0) known historic drainage problems At least one (1) known historic drainage problem Multiple (more than 1) known historic drainage 

problems
AND OR OR

Zero (0) in-line structures prior to the 10% 
analysis point

At least one (1) in-line structure prior to the 10% 
analysis point

Multiple (more than 1) in-line structures prior to 
the 10% analysis point

OR
Stream channel condition degraded due to 

vegetation, slope, erosion, etc.

Rating Criteria
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Total site area (ac):   ______________________
Total LOD area (ac): ______________________

Assessment Item
1. Soils - On-site soils have low permeability, high water table, or other limitations that could 

adversely affect adequate stormwater management for the proposed project. Number Yes/No Acres %

1.1  Hydric Soils within LOD (ac)
1.2  Drainage class "Poorly drained" or "Very poorly drained" within LOD (ac)
1.3  Hydrologic Soil Group "D" within LOD (ac)
1.4  Depth to water table < 100 cm within LOD (ac)
1.5  Flood frequency class "Frequent" or "Very frequent" within LOD (ac)
1.6  Ponding frequency class "Frequent" within LOD (ac)
1.7  Max. acreage for items 1.1 to 1.6 above within LOD (ac)

2. Runoff Potential - Change in land cover due to removal of trees, increases in impervious cover, 
etc. could adversely affect adequate stormwater management for the proposed project.

2.1  Existing wooded or meadow areas to be disturbed within LOD (ac)
2.2  Proposed increase in impervious area within LOD (ac)

3. Water Resource Protection - Site conditions may adversely affect runoff reduction and/or 
pollutant loading reductions.

3.1  Site area with Runoff Reduction Feasibility rating of Low or Low-Mod within LOD (ac)
3.2  Site area with water table <36 inches (100 cm) within LOD (ac)
3.3  Site area with HSG C or D soils within LOD (ac)

4. Sump Conditions - Existing topography of site creates depressional areas (closed 2' contours) 
where runoff tends to collect without direct discharge.

4.1  Site area that drains to sump (ac)

5. Discharge Points - Areas where stormwater runoff leaves the site have limitations due to low 
gradient, backwater effects, lack of a defined channel or other hydraulic limitations.

5.1  Discharge points with identified problems (no.)
5.2  Site area that drains to discharge point with identified problem (ac)

6. Off-Site Drainage - Areas draining into the site could adversely affect adequate stormwater 
management for the proposed project.

6.1  Off-site areas draining onto site (ac)

7. Conveyance - Downstream conditions such as inadequate pipe or channel capacity could limit 
adequate drainage from the site.

7.1  Known historic drainage problems (no.)
7.2  In-line structures between site and 10% analysis point (no.)
7.3  Stream channel condition degraded (yes/no)

Rating Value
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Workflow for Performing Site Level Hydrologic Analysis 
To Prepare Drainage Features Map 

1. Part 1 – LiDAR Pre-Processing using ArcGIS 9.3 

1.1.   Download DEM tile(s): http://datamil.delaware.gov/tiles/ 

1.2.   If area of interest includes more than 1 tile, create DEM mosaic 

1.2.1.  Open ArcCatalog; left-click on directory containing DEM tiles 

1.2.2.  Right-click one of the DEM tiles 

1.2.3.  Load>Load data… 

1.2.4.  Mosaic dialogue box will open; add other tiles to be mosaicked in “Input Rasters” field 

1.2.5.  Leave other fields in default values 

1.2.6.  Click “OK”  

1.2.7.  NOTE: Mosaicked DEM will retain name of original tile; it is recommended that 
mosaicked DEM be renamed to avoid file management problems 

1.3.   Zoom to  level adequate to define limits of both off-site and on-site drainage 

1.4.   Export LiDAR grid defined by data frame in Step 1.3 (NOTE:  When working with digital 
terrain files in ESRI grid format, file names and paths must not contain spaces and file names 
must be 13 characters or less.) 

1.4.1.   Right-click on grid file in TOC:  Data>Export Data… 

1.4.2.   Extent: Data Frame (Current) 

1.4.3.   Spatial Reference: Data Frame (Current) 

1.4.4.   Select location for output file 

1.4.5.   Format:  Grid 

2. Part 2 – Create Hydrologic Data using MapWindow GIS 

2.1.  Open MapWindow GIS and create new MapWindow GIS project 

2.1.1.   File>Save>Projectname.mwproj 

2.2.   Invoke the automated watershed delineation process: Watershed Delineation>Automatic 

2.3.   Select LiDAR grid “sta.adf” file created in Part 1 as “Base Elevation Data (DEM) Layer”; 
leave all remaining fields in default settings 

http://datamil.delaware.gov/tiles/


 
03/2013 3.02.1.4-2 

 

2.4.   Click “Run All” button 

2.5.   MapWindow GIS will create several grids and shapefiles in the “Terrain Analysis” layer 

2.6.   The following shapefiles will be used for further analysis in ArcGIS 9.3 

2.6.1.   Watershed Shapefile (projectnamew.shp) 

2.6.2.   Stream Reach Shapefile (projectnamenet.shp) 

2.7.   The following grid files will be used for further analysis in ArcGIS 9.2/9.3 

2.7.1.   Pit Filled Elevation Grid (projectnamefel.bgd)  

2.7.2.   Strahler Network Order Grid (projectnamegord.bgd) 

2.7.3.    Total Upslope Length Grid (projectnametlen.bgd) 

2.8. Since grid files identified in 2.7 are in MapWindow GIS’s native binary format, these will have 
to be converted into a format that ArcGIS 9.3 can import 

2.8.1.   GIS Tools>Raster>Change Grid Formats 

2.8.2.   Select grid files identified in 2.7; click “OK” 

2.8.3.   Set Output Options 

2.8.3.1. Output File Format:  ASCII (*.asc) 

2.8.3.2. Output Data Type:   

2.8.3.2.1. Pit Filled Elevation: Single Precision Float (4 bytes) 

2.8.3.2.2. Strahler Network Order:  Short Integer 

2.8.3.2.3. Total Upslope Length:  Single Precision Float (4 bytes) 

3. Part 3 – Site Hydrologic Analysis in ArcGIS 9.3 

3.1.   Load base grids, shapefiles and/or image files as desired 

3.2. Load shapefiles  identified in Step 2.6 

3.2.1.   To display Strahler Stream Order from Stream Reach Shapefile (projectnamenet.shp): 

3.2.1.1. Double-click on shapefile name in TOC 

3.2.1.2. Click “Symbology” tab 

3.2.1.3. Select Categories>Unique values  

3.2.1.4. Select “Order” from the “Value Field” drop-down menu 
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3.2.1.5. Click the “Add All Values” button 

3.2.1.6. Select desired Color Ramp (ex., Slope); click “OK” 

3.3.   Load converted “ASCII” grids identified in Step 2.7  

3.4.   ASCII grid files will need symbology adjustments for proper viewing in ArcGIS 

3.4.1.   Pit Filled Elevation Grid (projectnamefel.asc) 

3.4.1.1. Double-click on grid name in TOC 

3.4.1.2. Click “Symbology” tab 

3.4.1.3. Highlight “Stretched”  

3.4.1.4. Click “Use hillshade effect”; click “OK” 

3.4.2.     Strahler Network Order Grid (projectnamegord.asc) 

3.4.2.1. Double-click on grid name in TOC 

3.4.2.2. Click “Symbology” tab 

3.4.2.3. Select “Classified”; 

3.4.2.4. Click “Classify…” button; set number of classes equal to max. whole number 
value 

3.4.2.5. Select desired Color Ramp (ex., Cyan-Light to Blue-Dark) 

3.4.2.6. Double click on color button for value “1”; set to “No Color” 

3.4.3.   Total Upslope Length Grid (projectname tlen.asc) 

3.4.3.1. Double-click on grid name in TOC 

3.4.3.2. Click “Symbology” tab 

3.4.3.3. Select “Classified”; 

3.4.3.4. Click “Classify…” button  

3.4.3.5. Classification Method: Natural Breaks (Jenks) 

3.4.3.6. Classification Classes: 20 

3.4.3.7. Select desired Color Ramp (ex., Spectrum-Full Bright) 

3.4.3.8. Double click on color button for lowest range; set to “No Color” 

3.5.   Drainage network can now be analyzed by overlaying hydrologic layers on the base layers 
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4.   Part 4 - Optional Analytical Procedures 

4.1.1.   Tc Path from Stream Reach shapefile using ArcGIS 9.3 3D Analyst Extension 

4.1.1.1. Extend upper limit of Stream Reach shapefile to beginning of Tc path 

4.1.1.1.1. Editor>Start Editing 

4.1.1.1.2. Task: “Create New Feature” 

4.1.1.1.3. Target: “projectnamenet.shp” 

4.1.1.1.4. Editor>Snapping...; check “End” of “projectnamenet” layer 

4.1.1.1.5. Click Sketch tool; snap to end of Stream Reach shapefile 

4.1.1.1.6. Use Strahler Network Order Grid as template to digitize Tc path 

4.1.1.1.7. To finish digitizing, right-click and select “Finish Sketch” 

4.1.1.1.8. Editor>Stop Editing; “Yes” to save edits 

4.1.1.2. Trim Stream Network shapefile at terminus of Tc path 

4.1.1.2.1. Editor>Start Editing 

4.1.1.2.2. Task: Extend/Trim Features 

4.1.1.2.3. Target: projectnamenet.shp 

4.1.1.2.4. Select Stream Network shapefile with editing pointer tool 

4.1.1.2.5. Click Sketch tool 

4.1.1.2.6. Place 2 points to define a line across the Stream Network at the clip point 

4.1.1.2.7. Right-click>”Finish Sketch” (NOTE: if wrong segment is deleted; click the 
“Undo” button and place the 2 points again in reverse order) 

4.1.1.2.8. Editor>Stop Editing; “Save” edits 

4.1.1.3. Use Stream Network shapefile to create sheet, shallow & channel flow segments 
(NOTE: Pit Filled Elevation Grid may be used to generate a contour layer which 
can be used to determine appropriate segmentation of flow path) 

4.1.1.3.1. 100’ Sheet Flow 

4.1.1.3.1.1. Editor>Start Editing; select upper line segment 

4.1.1.3.1.2. Editor>Split…; “Split” dialogue box opens 
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4.1.1.3.1.3. “Distance along the line” (NOTE: linear units of Stream Network is 
identified on the Properties>Source tab) 

4.1.1.3.1.3.1.  Enter “30.5” if linear units of Stream Network are in meters 

4.1.1.3.1.3.2. Enter “100” if linear units of Stream Network are in feet  

4.1.1.3.1.4. Orientation: “From end Point of Line”; click “OK” 

4.1.1.3.1.5. Editor>Stop Editing; “Yes” to save edits 

4.1.1.3.1.6. Export sheet flow segment as new shapefile 

4.1.1.3.1.6.1. Select uppermost segment 

4.1.1.3.1.6.2. Right-click Stream Network shapefile 

4.1.1.3.1.6.3. Data>Export Data>Selected features 

4.1.1.3.1.6.4. Name new shapefile (ex., Tc_sheet) ; “Save” 

4.1.1.3.2. Shallow Concentrated Flow 

4.1.1.3.2.1.1. Editor>Start Editing 

4.1.1.3.2.1.2. Select appropriate segments of Stream Network shapefile to 
represent shallow concentrated flow path with editing pointer 
(NOTE: hold “Shift” key to select multiple segments) 

4.1.1.3.2.1.3. Editor>Merge; Merge dialogue box will open 

4.1.1.3.2.1.4. Accept highlighted segment to merge the selected features to 

4.1.1.3.2.1.5. Editor>Stop Editing; “Save” edits 

4.1.1.3.2.1.6. If Merge operation was successful, selecting on the Stream 
Network shapefile should highlight the entire shallow concentrated 
flow path 

4.1.1.3.2.1.7. Repeat as necessary for additional shallow concentrated flow 
segments 

4.1.1.3.2.1.8. Export shallow concentrated flow segment(s) as new shapefile(s) 

4.1.1.3.2.1.8.1. Select segment 

4.1.1.3.2.1.8.2. Right-click Stream Network shapefile 

4.1.1.3.2.1.8.3. Data>Export Data>Selected features 

4.1.1.3.2.1.9. Name new shapefile (ex., Tc_shallow) ; “Save” 
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4.1.1.3.3. Channel Flow 

4.1.1.3.3.1.1. The process for preparing channel flow segment(s) is the same as 
that for shallow concentrated flow described above 

4.1.1.3.3.1.2. Export channel flow segment(s) as new shapefile(s) 

4.1.1.3.3.1.2.1. Select segment 

4.1.1.3.3.1.2.2. Right-click Stream Network shapefile 

4.1.1.3.3.1.2.3. Data>Export Data>Selected features 

4.1.1.3.3.1.3. Name new shapefile (ex., Tc_channel) ; “Save” 

4.1.1.4. Add elevation attributes to Tc segments 

4.1.1.4.1. 3D Analyst>Convert>Features to 3D 

4.1.1.4.1.1.1. Input features: “Tc_sheet” 

4.1.1.4.1.1.2. Raster or TIN surface: Pit Filled Elevation Grid (projectname 
fel.asc) 

4.1.1.4.1.1.3. Output features: Name output shapefile (ex., Tc_sheetZ) 

4.1.1.4.2. Repeat for other Tc segments 

4.1.1.5. Generate profile plot & export to MS Excel 

4.1.1.5.1. Select Tc polylineZ segment 

4.1.1.5.2. 3D Analyst toolbar>Create Profile Graph button 

4.1.1.5.3. Right click on graph>Export 

4.1.1.5.4. Click “Data” tab 

4.1.1.5.5. Click “Excel” format 

4.1.1.5.6. “Save” 

4.1.1.5.7. Name file; “Save” 

4.1.1.5.8. Close dialogue boxes and repeat steps above for all Tc path segments 

4.1.1.5.9. Profile data may be charted and further analyzed in MS Excel 
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3.02.2 
Step 2: Preliminary Sediment & Stormwater Management Plan 
 
The Preliminary Sediment & Stormwater Management Plan shall be submitted only after 
the Project Application Meeting has been conducted and shall consist of the following 
elements: 

1. Schematic Construction Site Stormwater Management Plan  

2. Stormwater Management Report with accompanying Drainage Area Plans 

The submittal shall be accompanied by a completed Preliminary Sediment & 
Stormwater Plan Checklist.  An example Preliminary Sediment & Stormwater Plan 
Checklist is included as Appendix 3.02.2.1. 

The submittal package shall be reviewed for completeness by the Delegated Agency.  
Incomplete submittals will be returned in whole with the missing checklist items 
highlighted. 

If significant changes have been proposed for the site development plan, the Delegated 
Agency may require the applicant to repeat the Project Application process prior to 
reviewing the Preliminary Sediment & Stormwater Management Plan. 

An example Preliminary Sediment & Stormwater Management Plan is included as 
Appendix 3.02.2.8. 

 
Schematic Construction Site Stormwater Management Plan (CCSWM) 
The Preliminary Sediment & Stormwater Management Plan submitted at Step 2 of the 
plan review and approval process shall include a Schematic CSSWM Plan which 
provides an overview of the general measures to be used to control the site during the 
construction phase. 

The Schematic CSSWM Plan shall consist of the following elements (refer to the 
Preliminary Sediment and Stormwater Plan Checklist for all requirements): 

1. A single plan sheet scaled such that the entire site can be shown. 
2. Site boundary. 
3. Existing topography. 
4. Existing natural features, such as wooded areas, wetlands, etc. 
5. Proposed rough grading (at minimum flow arrows with approximate spot 

elevations). 
6. Graphic symbols for all ESC measures shown in their approximate proposed 

locations. 



 

03/2013 3.02.2-2 

7. Data for those practices having design data criteria. 
8. Legend using the symbols from the current Delaware ESC handbook. 

 

 

Stormwater Management Report and Drainage Area Plans 
A draft of the final Stormwater Management Report, including a site narrative, DURMM 
and other hydraulic and/or hydrologic computations, soils reports, and other 
supplemental information not previously included in the Stormwater Assessment Study, 
is to be prepared at the Preliminary stage.  The intent is to provide a thorough yet 
preliminary synopsis of the site’s construction and post construction controls.  Further in 
depth information can be supplemented in future submittals.    

Computations shall be included supporting the adequacy of proposed runoff reduction 
practices intended to comply with the requirements for the Resource Protection Event. 

Projects which qualify for the standards-based approach to comply with the 
requirements for the Conveyance Event and Flooding Event shall submit computations 
supporting the allowable unit discharges. 

All projects required or opting to use the performance-based approach to comply with 
the requirements for the Conveyance Event and Flooding Event shall submit hydrologic 
and/or hydraulic computations in accordance with Department guidance (see 
Appendices 3.02.2.3 and 3.02.2.4). 

Accompanying Drainage Area Plans should be included that depict the drainage 
boundaries and landuse covers used with the supplied computations. 

Refer to the Preliminary Sediment and Stormwater Plan Review Checklist (Appendix 
3.02.2.1) for additional information on both the Stormwater Management Report and the 
Drainage Area Plans.  

 



 

Sediment & Stormwater Management Plan Review Checklist 
 
DATE RECEIVED: _________________________    PROJECT NUMBER: ______________________ 
 
PROJECT NAME: ____________________________________________________________________ 
 
 
General Information: 
1. _____ One set of plans and reports, and a completed checklist must be submitted for each review.  

An electronic hardcopy of the plan and reports (i.e., PDF) shall also be transmitted for final 
approval.  Electronic program files (i.e., AutoCAD, MicroStation, DURMM, HydroCAD, and/or 
equal/similar) may be required upon agency request.   

2. _____ Hydraulic and Hydrology computations and plans shall be resubmitted, reflecting the updated 
site conditions, and be revised per the review comments from the preliminary submittal or the 
previous full submittal.  They should continue to follow the requirements specified in the 
Preliminary Sediment and Stormwater Management Plan Review Checklist.   

3. _____ All plans should be submitted on 24” x 36” (minimum) sheets unless otherwise approved. 
4. _____ When two (2) or more sheets are used to illustrate the plan view, an index sheet is required, 

illustrating the entire project on one (1) 24” x 36” (minimum) sheet. 
5. _____ Provide a north arrow on all plans. 
6. _____ All plan views, cross-sections, profiles, and structural details shall be to a defined scale. 
7. _____ Provide a scale bar for all plan views.   
8. _____ Provide names of adjacent property owners on all plans.   
9. _____ Provide existing and proposed contours based on NAVD 88 vertical datum at one (1) foot 

intervals (2 foot intervals can be provided for offsite drainage information based on the latest 
Lidar information).   

10. _____ For small projects less than ½ acre of disturbance, provide existing and proposed elevations 
based on NAVD 88 vertical datum on a fifty-foot grid system.  Include high and low points.   

11. _____ Locate the site in NAD83 horizontal datum.   
12. _____ Provide a copy of the Site Plan(s) and Grading Plan(s) as prepared for the local approval 

agencies for review and informational purposes.   
13. _____ Provide a copy of the preliminary Record Plan as prepared for the local landuse approval 

agency for review and informational purposes. 
14. _____ All detailed plans submitted for review shall be prepared, signed, dated and sealed by a 

Licensed Professional in the State of Delaware.    
15. _____ Provide the Sediment and Stormwater Management plans in the following order and title 

(sheet list to appear on the Coversheet, and each plan sheet shall be respectively titled): 
a. _____ Coversheet and General Notes 
b. _____ Overall Construction Site Phasing Plan (if applicable) 
c. _____ Overall Pre-Construction Site Stormwater Management Plan (if applicable) 
d. _____ Pre-Construction Site Stormwater Management Plan #X 
e. _____ Overall Construction Site Stormwater Management Plan (if applicable) 
f. _____ Construction Site Stormwater Management Plan #X 
g. _____ Construction Site Details and Notes (including the Sequence of Construction)  
h. _____ Overall Post Construction Stormwater Management Plan 
i. _____ Post Construction Stormwater Management Plan, Facility #X 
j. _____ Overall BMP Contributing Drainage Area Plan (To be included in final Stormwater 

Report) 
k. _____ BMP Contributing Drainage Area Plan (To be included in final Stormwater Report) 
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l. _____ Pre-Developed Subarea Limit of Disturbance Drainage Area Plan (To be included 
in final Stormwater Report) 

m.  
n.  

16. _____ For final approval, the following items shall be submitted: 
a. _____ Completed NOI and associated fee must be submitted to DNREC.   
b. _____ Provide a copy of the recorded permanent easement when a stormwater facility or 

outfall is located outside of the property boundary. 
c. _____ Provide a wetland permit when construction of a stormwater facility will impact 

State and/or Federal wetlands. 
d. _____ Provide an approval letter from the DNREC Drainage Section for any 

encroachment or change in runoff discharge to an existing tax ditch or adjacent 
right-of-way.  

Coversheet: 
17. _____ Project Header: 

a. _____ Project Name (and Phase, if applicable; to duplicate in the title block on each 
sheet). 

b. _____ Title of Plan Set: Sediment and Stormwater Management Plans (to duplicate in 
the title block on each sheet) 

c. _____ Project Location (including watershed, hundred, town, county, etc., as applicable).   
d. _____ Project tax map identification number(s).   

18. _____ Legend indicating plan symbols and lines, including but not limited to, soils, drainage area 
information, grading and site information. 

19. _____ Provide a vicinity map with a scale appropriate to project size, and indicate the site boundary 
within the map.  The map shall be no smaller than 4”x4” in size and shall clearly indicate at 
least one intersecting road.   

20. _____ Project Notes:  
a. Parcel Data: 

i. _____ Project tax map identification number(s) 
ii. _____ PLUS Number (if applicable) 
iii. _____ DNREC Sediment and Stormwater Program [or relevant Delegated Agency] 

Number 
iv. _____ Site Address (or Nearest Intersecting Street and Distance between) 
v. _____ Latitude and Longitude State Plane coordinates, with approximate 

geographical location (ie, Benchmark #1, Northeast Site Corner, etc).  
Provide in degree decimal format.   

vi. _____ Existing Site Area 
vii. _____ Proposed Site Area 
viii. _____ Existing Wetland Area 
ix. _____ Proposed Condition (ie, number of lots, total building square footage, etc) 
x. _____ Proposed Discharge Location(s) 
xi. _____ Proposed Total Limit of Disturbance per Discharge Location  

b. Contact Data: 
i. Contact Name, Title: ____ Owner  ____ Developer  ____ Designer  ____ Agency 
ii. Company/LLC:     ____ Owner  ____ Developer  ____ Designer  ____ Agency 
iii. Full Street Address:  ____ Owner  ____ Developer  ____ Designer  ____ Agency 
iv. Phone Number:      ____ Owner  ____ Developer  ____ Designer  ____ Agency 
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21. _____ Include a signed Owner’s Certification that states “I, the undersigned, certify that all land 
clearing, construction and development shall be done pursuant to the approved plan and that 
responsible personnel (i.e., Blue Card Holder) involved in the land disturbance will have a 
Certification of Training prior to initiation of the project, at a DNREC sponsored or approved 
training course for the control of erosion and sediment during construction.  In addition, I grant 
the DNREC Sediment and Stormwater Program and/or the relevant Delegated Agency the 
right to conduct on-site reviews, and I understand my responsibilities under the NPDES 
Construction General Permit, as referenced on this Coversheet.”  This must be signed in ink 
on each plan submitted or on an original reproducible.  Include the owner’s name and title 
printed under the signature line. 

22. _____ If during the SAS review meeting it is determined that a wetland delineation is required onsite, 
include a Wetland Certification, signed in ink, stating the site has been examined to both State 
and Federal requirements.  The following shall be used unless an alternate has been 
approved: “This property, tax map #XXX, has been examined by [company name] for the 
presence of Waters of the United States, including wetlands (Section 404 and Section 10), 
State subaqueous lands and State regulated wetlands as established by the reviewing 
agencies in the form of manuals, policies and procedures in place at the time that the 
investigation was conducted.  The wetland information contained in this plan set is in 
accordance with this criteria [or, There were no wetlands found within the subject property], 
per State JD #XXX and/or Army Corps JD #XXX [as applicable]. 

23. _____ Include a signed Licensed Professional Certification that states “I hereby certify that this plan 
has been prepared under my supervision and to the best of my knowledge complies with the 
applicable state and local regulations and ordinances.” 

24. _____ Include the following Standard Sediment and Stormwater Construction Notes: 
a. _____ “The DNREC Sediment and Stormwater Program must be notified in writing five 

(5) days prior to commencing with construction.  Failure to do so constitutes a 
violation of the approved Sediment and Stormwater Management Plan.” 

b. _____ “Review and or approval of the Sediment and Stormwater Management Plan shall 
not relieve the contractor from his or her responsibilities for compliance with the 
requirements of the Delaware Sediment and Stormwater Regulations, nor shall it 
relieve the contractor from errors or omissions in the approved plan.” 

c. _____ “If the approved plan needs to be modified, additional sediment and stormwater 
control measures may be required as deemed necessary by DNREC or the 
Delegated Agency”. 

d. _____ “Following soil disturbance or redisturbance, permanent or temporary stabilization 
shall be completed for  all perimeter sediment controls, soil stockpiles, and all 
other disturbed or graded areas on the project site within 14 calendar days unless 
more restrictive Federal requirements apply.” 

e. _____ "All erosion and sediment control practices shall comply with the Delaware Erosion 
and Sediment Control Handbook, latest edition.” 

f. _____ “At any time a dewatering operation is used, it shall be previously approved by the 
Agency Construction Site Reviewer for a non-erosive point of discharge, and a 
dewatering permit shall be approved by the DNREC Well Permitting Branch.” 

g. _____ “Approved plans remain valid for 3 years from the date of approval.” 
h. _____ “Post construction verification documents are to be submitted to the DNREC 

Sediment and Stormwater Program [or, the relevant Delegated Agency ] within 
60-days of stormwater management facility completion.” 
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i. _____ “Approval of a Sediment and Stormwater Management Plan does not grant or 
imply a right to discharge stormwater runoff. The owner/developer is responsible 
for acquiring any and all agreements, easements, etc., necessary to comply with 
State drainage and other applicable laws.” 

j. _____ “The Notice of Intent for Storm Water Discharges Associated with Construction 
Activity under a NPDES General Permit for this project is #______ (to be filled in 
once received). At any time the ownership for this project changes, a Transfer of 
Authorization or a Co-Permittee Application must be submitted to DNREC.  The 
permittee of record shall not be relieved of their responsibilities until a Notice of 
Termination has been processed by DNREC.”  

k. _____ “The owner shall be familiar with and comply with all aspects of the NPDES 
Construction General Permit associated with the project, including, but not limited 
to, performing weekly site inspections during construction and after rain events, 
and maintaining written logs of these inspections.” 

l. _____ “Before any earthwork or excavation takes place, the contractor shall call Miss 
Utility at 811 or 1.800.282.8555 at least 48 hours prior to construction, to have all 
existing utilities marked onsite.” 

m. _____ “The contractor shall at all times protect against sediment or debris laden runoff or 
wind from leaving the site.  Perimeter controls shall be checked daily and adjusted 
and/or repaired to fully contain and control sediment from leaving the site.  
Accumulated sediment shall be removed when it has reached half of the effective 
capacity of the control.  In addition, the contractor may need to adjust or alter 
measures in times of adverse weather conditions, or as directed by the Agency 
Construction Site Reviewer.” 

n. _____ “Best available technology (BAT) shall be employed to manage turbid discharges 
in accordance with requirements of 7. Del C. Ch 60, Regulations Governing the 
Control of Water Pollution, Section 9.1.02, known as Special Conditions for 
Stormwater Discharges Associated with Construction Activities, and Department 
policies, procedures, and guidance.”  

o. _____ “Documentation of soil testing and materials used for temporary or permanent 
stabilization including but not limited to soil test results, seed tags, soil 
amendment tags, etc. shall be provided to the Department or Delegated Agency 
to verify that the permanent or temporary stabilization has been completed in 
accordance with the approved plan. The Department or Delegated Agency may 
require additional soil testing and reapplication of permanent or temporary 
stabilization in accordance with specifications provided in the Delaware Erosion 
and Sediment Control Handbook, or alternative measures that provide functional 
equivalency.  

25. _____ Provide a list of all sheets and their corresponding sheet number for all Sediment and 
Stormwater Management Plans.  

26. _____ Provide a minimum 3”x5” clear area for an approval stamp on the right third of the coversheet.   
 
Construction Site Stormwater Management Plans: 
27. _____ Overall Construction Site Phasing Plan: 

a. _____ Provide only when the site has more than one limit of disturbance.  Projects must 
be phased so that no more than 20 acres are disturbed at any one time. Grading 
of the next phase cannot proceed until temporary or permanent stabilization of the 
first 20-acre section is accomplished. 
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b. _____ Clearly indicate the extents of each phase in relation to the site plan (no existing or 
proposed grading). 

c. _____ Indicate the location of the detailed sheets by matchline and page number 
reference. 

d. _____ Provide a summary/legend for the limit of disturbance areas, indicating their total 
disturbed acreage and the lots, buildings and/or stormwater facilities that are 
included within the limit of disturbance.     

28. _____ For all of the subsequent Pre-Construction and Construction Site Stormwater Management 
Plans include the following: 
a. _____ Provide the “limit of disturbance” line(s).  
b. _____ Include the total disturbed acreage on the plan if an Overall Phasing Plan has not 

been included. 
c. _____ Existing contours shall be provided a minimum of 100’ beyond the limit of 

disturbance.  LiDAR 2’ contours are acceptable for off-site areas.   
d. _____ State and Federal wetlands must be accurately delineated. 
e. _____ All streams and drainage ways must be delineated. 
f. _____ The National Flood Insurance Program 100 Year Flood Zone must be delineated. 
g. _____ Show the project benchmark and identify the elevation and datum. 

29. _____ Overall Pre-Construction Site Stormwater Management Plan (if required, as determined at the 
SAS review meeting): 
a. _____ Provide only for sites that cannot be shown in their entirety at the maximum scale 

of 1”=100’. 
b. _____ Include the entire site boundary in an existing conditions plan view (ie, site 

boundary, existing contours, wetlands, treelines, existing structures/utilities to 
remain or to be removed, etc). 

c. _____ Indicate the location of all perimeter controls, stockpile locations, sediment 
trapping facilities, and other construction stormwater management controls  
needed for demolition and bulk grading (i.e., silt fence, stabilized construction 
entrances, temporary swales, inlet protection for existing inlets, sediment basins, 
etc). 

d. _____ Indicate the location of the detailed sheets by matchline and page number 
reference. 

e. _____ Provide a Legend for all of the construction site lines and symbols used within the 
Pre-Construction Plan (ie, silt fence, limit of disturbance, temporary berm, etc).  
The lines and symbols should be as specified in the Delaware Erosion and 
Sediment Control Handbook, latest edition.  If an Overall plan is not needed, 
provide the legend on the singular Pre-Construction Site Stormwater Management 
Plan.   

30. _____ Pre-Construction Site Stormwater Management Plan (if required, as determined at the SAS 
review meeting): 
a. _____ Provide for all sites at a maximum scale of 1” = 100’. 
b. _____ Include the entire site boundary in an existing conditions plan view (ie, site 

boundary, existing contours, wetlands, treelines, existing structures/utilities to 
remain or to be removed, etc). 

c. _____ Indicate the location of all perimeter controls, stockpile locations, sediment 
trapping facilities, and other construction stormwater management controls  
needed for demolition and bulk grading (i.e., silt fence, stabilized construction 
entrances, temporary swales, sediment basins, etc). 
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d. _____ Provide detailed labels and specifications for the controls utilized (i.e. “Data to be 
Provided” or “Data” blocks from the Delaware Erosion & Sediment Control 
Handbook, latest edition, details). 

 
31. _____ Overall Construction Site Stormwater Management Plan: 

a. _____ Provide only for sites that cannot be shown in their entirety at the maximum scale 
of 1”=100’. 

b. _____ Clearly indicate all of the construction stormwater management controls for the 
site in relation to the site’s grading and stormwater facilities.  

c. _____ Indicate the location of the detailed sheets by matchline and page number 
reference. 

d. _____ Provide a Legend for all of the construction site lines and symbols used within the 
plan set (ie, silt fence, limit of disturbance, inlet protection, etc).  The lines and 
symbols should be as specified in the Delaware Erosion and Sediment Control 
Handbook, latest edition.  If an Overall plan is not needed, provide the legend on 
the singular Construction Site Stormwater Management Plan.   

32. _____ Construction Site Stormwater Management Plan(s): 
a. _____ Provide for all sites at a maximum scale of 1” = 100’. 
b. _____ Clearly indicate all of the construction stormwater management controls for the 

site in relation to the site’s grading and stormwater facilities.     
c. _____ Provide detailed labels and specifications for the controls utilized (i.e. “Data to be 

Provided” or “Data” blocks from the Delaware Erosion & Sediment Control 
Handbook, latest edition, details). 

d. _____ Locate all utilities, construction staging areas, geothermal well-fields, and any/all 
other areas that construction equipment will traverse or disturb.  These areas 
must be within the limit of disturbance and be provided with appropriate 
construction site controls.   

33. _____ For all Pre-Construction and Construction Site Stormwater Management Plans locate and 
label all construction site stormwater control practices on the plans as previously mentioned.  
The following shall be included, unless supporting evidence of why they are not necessary is 
addressed in the revised Stormwater Management Report.  The list is not exhaustive and the 
construction site design shall include any/all control practices contained within the Delaware 
Erosion and Sediment Control Handbook, or others as approved by DNREC, that are 
necessary to prevent sediment and pollution discharge from the site. 
a. _____ An approved perimeter control shall be placed downslope of all disturbed areas (or 

surrounding “flat areas”) to protect against sediment laden runoff from leaving the 
site or entering non-disturbed areas.  It should be placed parallel to the contours 
and keyed perpendicular to the contours at the limits to prevent sediment from 
washing around the ends.  Locate and denote the type with any specifications.  

b. _____ Reinforced and/or super silt fence should be utilized in areas of steep slopes 
and/or adjacent to sensitive areas such as wetlands, streams, and drainage ways. 

c. _____ Orange safety fencing shall be provided around all infiltration areas and noted that 
no heavy construction equipment shall traverse the future infiltration area. 

d. _____ Orange safety fencing is recommended to be placed around the drip line of all 
preserved trees.    

e. _____ Soil stockpile areas must be delineated for each phase of construction.  Locate 
stockpiles on areas with little or no slope.  Stockpiles must be surrounded with an 
approved perimeter control.   
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f. _____ Locate a stabilized construction entrance(s) for each phase of construction, and 
provide appropriate measures to ensure traffic utilizes the entrance (ie, keying silt 
fence up to the entrance). 

g. _____ Sediment traps and basins shall be utilized as appropriate and sized to 
accommodate 3600 cubic feet of storage per acre of contributing drainage area 
until project stabilization is complete.  These structures must be located at the 
base of the drainage area.  The following information is required: top of slope 
elevation, bottom elevation, outlet elevation, dimensions, proposed volume, 
required volume, type of trap or basin, a minimum 2:1 length to width ratio and 
contributing drainage area.  Include details, cross-sections and specifications.  
This information can be combined with the facility’s Post Construction Stormwater 
Management Plan as appropriate. 

h. _____ Specify the location, DNREC denoted type, and an example product for all 
stabilization practices, including any treatments, seeding, mulching and/or 
matting, both temporary and permanent. 

i. _____ Erosion control matting is required on slopes of 3:1 or greater and in areas of 
concentrated flow.  Specify the DNREC denoted type, with an example product, 
and the location of the matting. 

j. _____ Channel interruptions are required in all swales, ditches and channels, with 
velocities greater than 2 ft/sec.  Locate and denote the type with any 
specifications.   

k. _____ Provide steep slope interruption by use of straw wattles, coir logs, etc.  Locate and 
denote the type with any specifications.  

l. _____ Provide appropriate inlet protection for all catchbasins and culvert inlets.  Locate 
and denote the type with any specifications.   

m. _____ Diversions must be used to direct run-off into traps.  When sediment laden 
stormwater is directed to traps and basins by closed pipe systems, temporary 
diversions must be used to direct stormwater to traps and basins until closed pipe 
systems are operational.  Locate and denote the type with any specifications. 

n. _____ Outlet protection is required at all points of discharge from pipes, channels and 
spillways.  Locate and provide details, cross-sections and specifications, including 
d50 stone size, stone depth, outlet dimensions and type of geotextile fabric. 

o. _____ All stone, with the exception of check dams, must be underlain with a geotextile 
fabric, or approved equivalent practice.  Geotextile fabric specifications must be 
provided for various applications, with the DNREC denoted type and an example 
product. 

p. _____ Provide a location a concrete washout station and construction staging areas, 
including dumpster(s).  Note that if the locations are to be moved, it shall be 
approved in writing by the Agency Construction Site Reviewer. 

 
Construction Site Details and Notes: 
34. _____ Specify whose responsibility it will be to maintain and repair all erosion and sediment control 

and stormwater management practices during construction and utility installation. 
35. _____ Specify what stabilization measures shall be initiated if dust control becomes a problem. 
36. _____ Provide the volume of any spoil or borrow material. 
37. _____ Provide a detailed sequence of construction, and at a minimum include the following activities: 

a. _____ pre-construction meeting; 
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b. _____ clearing and grubbing for those areas necessary for installation of perimeter 
controls; 

c. _____ construction of perimeter controls; 
d. _____ remaining clearing and grubbing; 
e. _____ road grading; 
f. _____ grading for the remainder of the site,  
g. _____ utility installation; 
h. _____ stormwater facility construction; 
i. _____ final grading, landscaping or stabilization; 
j. _____ removal of sediment control practices.   

38. _____ Include the following specific items as appropriate within the Sequence of Construction: 
a. _____ “Notify the DNREC Sediment and Stormwater Program [or relevant Delegated 

Agency] in writing at least five (5) days prior to the start of construction. Failure to 
do so constitutes a violation of the approved Sediment and Stormwater 
Management Plan.” 

b. _____ “Prior to any clearing, installation of sediment control measures or grading, a pre-
construction meeting must be scheduled and conducted with the Agency 
Construction Site Reviewer. The landowner/developer, contractor, and Certified 
Construction Reviewer are required to be in attendance at the pre-construction 
meeting; the designer is recommended to attend.” 

c. _____ “All perimeter controls are to be reviewed by the Agency Construction Site 
Reviewer and approved prior to proceeding with further site disturbance or 
construction.” 

d. _____ “The contractor shall at all times protect against sediment or debris laden runoff or 
wind from leaving the site.  Perimeter controls should be checked daily and 
adjusted and/or repaired to fully contain and control sedimentation on the site.  
Accumulated sediment shall be removed when it has reached half of the effective 
capacity of the control.  In addition, the contractor may need to adjust or repair 
measures in times of adverse weather conditions, or as directed by the Agency 
Construction Site Reviewer.”   

e. _____ “Notify the person responsible for stormwater system construction review at least 
three (3) days prior to the start of the stormwater system construction; stormwater 
facilities must be reviewed throughout their construction.”   

f. _____ “Erosion and sediment control devices should be removed only after work in an 
area has been completed and stabilized, with written approval from the Agency 
Construction Site Reviewer.”  

g. _____ “Prior to commencing a new phase of construction, the contractor shall receive 
approval from the Agency Construction Site Reviewer that the previous phase has 
been sufficiently stabilized.” 

h. _____ “The termination of the Construction General Permit will require submission and 
acceptance of the Post Construction Verification Documents, including final 
stabilization throughout the site, all elements of the Sediment and Stormwater 
Management Plan implemented, and acceptance of the final Operation and 
Maintenance Plan.”   

39. _____ Provide details and specifications for all erosion and sediment control management practices 
used.  All details shall be from the Delaware Erosion and Sediment Handbook (any unusual 
practices must be approved for use by the Department).  The following details must be 
incorporated: 
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a. _____ Stabilized Construction Entrance 
b. _____ Perimeter Control (i.e., Silt Fence, Temporary Berm, etc) 
c. _____ Temporary and Permanent Seeding and Stabilization 
d. _____ Sediment Trapping (i.e., Inlet Protection, Sediment Basins, etc) 
e. _____ Site Pollution Prevention including Concrete Washout 
f. _____ Dewatering Practice(s) 
g. _____ Individual Lot Control (for residential use only)  
h. _____ All other applicable details to the site. 

40. _____ Provide the “Data to be Provided” for all Erosion and Sediment Control practices having design 
data criteria.  The data should be provided in the corresponding detail, or a note should be 
provided to refer to the relevant chart for the information.   

 
Post Construction Stormwater Management Plan 
41. _____ Provide an Overall Post Construction Stormwater Management Plan indicating the location 

and identification of all stormwater facilities in relation to the proposed site and the existing 
and proposed grading.     
a. _____ The National Flood Insurance Program 100 Year Flood Zone must be delineated. 
b. _____ Show project benchmark and identify elevation and datum. 
c. _____ The plan shall indicate any easements, rights-of-way, and/or demarcation of 

where public maintenance responsibility ends and private maintenance begins 
throughout the stormwater and drainage system, and clearly distinguish who is 
responsible for the maintenance in each area. 

42. _____ Provide a detailed Post Construction Stormwater Management Plan per facility clearly showing 
the proposed construction and specifications, including: 
a. _____ Plan view of the facility indicating any/all: benches, inlets, outlets and their 

associated elevation; seed and stabilization type and locations; cross-section 
locations; grading of the facility; forebays; subsurface testing boring locations; etc.  
The maximum scale of facility shall be 1” = 30’. 

b. _____ Cross-section view of the facility to a defined scale, indicating any/all: benches; 
water surface elevations; depth of construction; location of liners or underdrains; 
slopes; structures and/or pipes; seed and stabilization type and locations; 
embankment specifications; existing and proposed grade; fill locations; etc.  

c. _____ Cross-section view of the principal spillway to a defined scale, including the entire 
length of the discharge pipe, indicating any/all: water surface elevations; location 
of liners; slopes; phreatic lines; structure details; embankment specifications; anti-
seep collar location(s); crossings; outfall details; existing and proposed grade; etc.  
Extend the view to include the opposite side of any outfall ditch, and location of 
any wetlands, as applicable.   

d. _____ Cross-section views of the emergency spillway(s) to a defined scale, both through 
the width and length of the spillway, indicating any/all: water surface elevations; 
location of liners; slopes; embankment specifications; stabilization specifications; 
outfall details; existing and proposed grade; etc.  Extend the view to include the 
opposite side of any outfall ditch, and location of any wetlands, as applicable.   

e. _____ Plan and section views to a defined scale for any structures within the facility 
including any/all construction specifications, inverts, water surface elevations, etc. 

f. _____ Notes and specifications for the facility, including, but not limited to, seed and 
stabilization type and locations, de-watering specifications, 
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groundwater/subsurface information, construction information and facility specific 
information (i.e., type of liner, biosoil, stone, etc.). 

g. _____ If the vegetation within the facility is used for quality management purposes, a 
separate Landscape Plan shall be prepared indicating the species type, number 
and planting locations, and be signed by a licensed Landscape Architect in the 
State of Delaware. 

h. _____ The plan shall indicate any easements, rights-of-way, and/or demarcation of 
where public maintenance responsibility ends and private maintenance begins 
within or around the facility, and clearly distinguish who is responsible for the 
maintenance in each area. 

i. _____ Provide directional stormwater flow arrows for all existing and proposed channels, 
pipes, etc. 

j. _____ Provide details, cross-sections and specifications (including appropriate channel 
lining, type of vegetation, or type of stabilization) for any diversions, ditches, 
swales, etc., not classified as a facility but are being proposed or accepting 
discharge. 

k. _____ All stormwater designs shall be in accordance with standards developed and/or 
approved by the DNREC Sediment and Stormwater Program. 

l. _____ Maintenance set aside areas for disposal of sediments removed from stormwater 
management facilities that provide a forebay must be provided.  Set aside areas 
shall accommodate at least 2% of the stormwater management facility volume to 
the elevation of the 2 year storage volume elevation, maximum depth of the set 
aside volume shall be one foot, and the slope of the set aside area shall not 
exceed 5%. 

m. _____ Include in the agency submittal any design checklists for the specific type of facility 
as provided by DNREC.  

n. _____ Provide a Sequence of Construction specific to the facility, indicating the methods 
for excavation, construction of structures or other controls, stabilization, 
dewatering, temporary or permanent sediment controls, etc.   

o. _____ Provide Operation and Maintenance (O&M) notes and/or details (if more than one 
sheet is required per facility, then the O&M requirements shall all be combined on 
the same sheet).  Including the below statements and requirements shall satisfy 
the Operation and Maintenance Plan requirements for this stage of plan review 
(once the facility is constructed, a full Operation and Maintenance Plan shall be 
prepared and include the post verification construction drawing. 

i. _____ “The DNREC Sediment and Stormwater Program and/or the relevant 
Delegated Agency reserves the right to enter private property for 
purposes of periodic site reviews.” 

ii. _____ “The DNREC Sediment and Stormwater Program [or the relevant 
Delegated Agency] shall be notified within 30 business days if the 
property ownership is transferred to a new person or entity.” 

iii. _____ “The DNREC Sediment and Stormwater Program and/or the relevant 
Delegated Agency may seek enforcement action against any owner 
deemed negligent in fulfilling the Operation and Maintenance 
requirements of the Delaware Sediment and Stormwater Regulations.” 

iv. _____ “The DNREC Sediment and Stormwater Program [or, the relevant 
Delegated Agency] shall be contacted if a concern arises regarding a 
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stormwater management facility, before any non-routine maintenance, or 
if modifications to the facility are desired.”  

v. _____ “Any design modifications made to the stormwater system shall require 
the creation of a new Post Construction Stormwater Management Plan 
and/or Operations and Maintenance Plan, with approval of the plan(s) by 
the DNREC Sediment and Stormwater Program [or the relevant 
Delegated Agency].”   

vi. _____ “For all stormwater easement areas (i.e., access, maintenance, or offsite) 
and the minimum 10-foot wide accessways to all stormwater facilities and 
their structural components, regular mowing shall be performed to keep 
the grass 6” or less; no trees or shrubs shall be planted, and any found 
growing shall be removed; and no permanent structures, such as fences 
or sheds, shall be located within the easement or accessway.” 

vii. _____ “Trees shall not be planted, and shall be removed if found growing, on and 
within 15 feet of all pond embankments, on pond slopes or safety 
benches, and within 10 feet of structural components, such as pipe inlets.”  

viii. _____ “When the facility is excavated to remove accumulated sediment, the 
disposal area shall be permanently stabilized so that it does not recreate 
an erosion problem.  Any material taken off-site shall still be utilized or 
disposed of in an approved DNREC manner.” 

ix. _____ “Before any earthwork or excavation takes place, the contractor shall call 
Miss Utility at 811 or 1.800.282.8555 at least 48 hours prior to 
construction, to have all existing utilities marked onsite.” 

x. _____ Include the O&M notes specified for the type of facility proposed, as per 
Appendix 5.01.1 and/or section 3.06.2 Post Construction Stormwater 
BMP Standards and Specifications of the Technical Document. 

xi. _____ Include any facility specific routine or non-routine maintenance, and/or 
operational requirements not listed in the above-mentioned standard 
requirements for the type of facility.  May include, but is not limited to any 
mowing, sediment removal, pipe inspections, watering, re-
seeding/planting, trash removal, etc 
1. _____ The notes shall indicate the frequency of the maintenance 

inspections. 
2. _____ Any O&M specifications for proprietary systems must be 

included on the plans.   
3. _____ Any details necessary to complete the O&M procedures must 

be included. 
43. _____ For stormwater management practices incorporating infiltration, the following apply: 

a. _____ Infiltration practices designed to handle runoff from impervious parking areas must 
maintain a separation distance of 100 feet from domestic wells and 150 feet from 
public wells from their periphery. 

b. _____ Infiltration practices greater than three feet deep shall be located at least 20 feet 
from basement walls.  Any infiltration practice shall be located at least 10 feet from 
a building structure.  

c. _____ Areas draining to these practices must be stabilized and vegetative filters 
established prior to runoff entering the system.  If individual lot construction is to 
drain towards an already established infiltration area, the facility shall be protected 
with perimeter controls around the top of bank.   
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d. _____ The infiltration practice shall be designed to drain completely within 48 hours. 
e. _____ The bottom of the infiltration practice shall be at least three feet above the 

seasonal high water table, unless a BMP specification indicates otherwise.   
f. _____ Infiltration practices are limited to soils having a field tested infiltration rate of at 

least 1 inch per hour; the design infiltration rate shall be half of the field tested 
infiltration rate.  Onsite soil borings and textural classification must be done to 
verify site conditions and seasonal high water table, this information must be 
submitted with the plan.    

g. _____ Infiltration practices shall not be installed in fill material.   
 
 
Note: For any language that contains “[or the relevant Delegated Agency]”, the preparer shall substitute the name 
of the appropriate Delegated Agency in place of the DNREC Sediment and Stormwater Program.  For example, if the 
Sussex Conservation District is the Delegated Agency for the project, the checklist item “I am to notify the DNREC 
Sediment and Stormwater Program [or the relevant Delegated Agency]” would be prepared as “I am to notify the 
Sussex Conservation District”.  Any “and/or” statements shall remain as prescribed.  For example, “I grant the 
DNREC Sediment and Stormwater Program and/or the relevant Delegated Agency” can be copied verbatim, and 
grants either agency the right to enter the property as may become necessary throughout the duration of the 
project.    
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Preliminary Sediment & Stormwater Management Plan Review Checklist 
 
DATE RECEIVED: _________________________    PROJECT NUMBER: ______________________ 
 
PROJECT NAME: ____________________________________________________________________ 
 
 
General Information: 
1. _____ Completed application signed by the owner, review fee, one set of plans and reports, and a 

completed checklist must be submitted for review.  Electronic plan and report program files 
(i.e., AutoCAD, Microstation, DURMM, HydroCAD, and/or equal/similar) shall be transmitted 
upon agency request.   

2. _____ Provide a copy of the notice to DelDOT, a municipality, or a private entity (i.e., neighboring 
Homeowner’s Association) for the intent to discharge or connect to their stormwater system.  
The notice shall indicate the proposed condition and that any comments regarding the 
discharge shall be returned within 30 calendar days, and if no comments are received than 
consent to discharge is assumed.  If directly copied on the notice, indicate the date of the 
notice and the reviewer copied: _________________________________________________. 

3. _____ Hydraulic and Hydrology computations shall reflect the proposed site conditions.   
4. _____ All plans should be submitted on 24” x 36” (minimum) sheets unless otherwise approved. 
5. _____ When two (2) or more sheets are used to illustrate the plan view, an index sheet is required, 

illustrating the entire project on one (1) 24” x 36” (minimum) sheet. 
6. _____ Provide a north arrow on all plans. 
7. _____ Provide all plan views to a defined scale with a scale bar.   
8. _____ Provide names of adjacent property owners on all plans. 
9. _____ Provide existing and proposed contours (if provided) based on NAVD 88 vertical datum at one 

(1) foot intervals (2 foot intervals can be provided for offsite drainage information based on the 
latest Lidar information).   

10. _____ For small projects less than ½ acre of disturbance, provide existing and proposed spot 
elevations based on NAVD 88 vertical datum on a fifty-foot grid system.  Include high and low 
points.   

11. _____ Locate the site in NAD83 horizontal datum.   
12. _____ Provide the contact information for the person or entity responsible for preparing the plans and 

report, including name, company, address and telephone number..  Locate on both the plans 
and report. 

13. _____ All detailed plans submitted for review shall be prepared, signed, dated and sealed by a 
Licensed Professional in the State of Delaware.    

14. _____ Provide the Preliminary Sediment and Stormwater Management plans in the following order 
and title.  The sheet list is to appear on the Coversheet, and on each plan sheet shall be 
respectively titled (include the title of the plan within the title block or lower right-hand corner of 
the sheet): 
a. _____ Coversheet 
b. _____ Schematic Pre-Construction Site Stormwater Management Plan 
c. _____ Schematic Construction Site Stormwater Management Plan  
d. _____ Overall BMP Contributing Drainage Area Plan 
e. _____ BMP Contributing Drainage Area Plan 
f. _____ Pre-Developed Subarea Limit of Disturbance Drainage Area Plan 
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Coversheet: 
15. _____ Project Header: 

a. _____ Project Name and Phase (to duplicate in the title block on each sheet). 
b. _____ Title of Plan Set: Preliminary Sediment and Stormwater Management Plans (to 

duplicate in the title block on each sheet) 
c. _____ Project Location (including watershed, hundred, town, county, etc., as applicable).   
d. _____ Project tax map identification number(s).   

16. _____ Legend indicating plan symbols and lines, including but not limited to, soils, drainage area 
information, grading and site information. 

17. _____ Provide a vicinity map with a scale appropriate to project size, and indicate the site boundary 
within the map.  The map shall be no smaller than 4”x4” in size and shall clearly indicate at 
least one intersecting road.   

18. _____ Project Notes:  
a. Parcel Data: 

i. _____ Project tax map identification number(s) 
ii. _____ PLUS Number (if applicable) 
iii. _____ DNREC Sediment and Stormwater Program [or relevant Delegated 

Agency] Number 
iv. _____ Site Address (or Nearest Intersecting Street and Distance between) 
v. _____ Latitude and Longitude State Plane coordinates, with approximate 

geographical location (ie., Benchmark #1, Northeast Site Corner, etc).  
Provide in degree decimal format. 

vi. _____ Existing Site Area 
vii. _____ Proposed Site Area 
viii. _____ Existing Wetland Area 
ix. _____ Proposed Discharge Location(s) 
x. _____ Proposed Total Limit of Disturbance per Discharge Location 

b. Contact Data: 
i. Owner’s Name, Title: _____ Owner     _____ Land Developer     _____ Designer 
ii. Company/LLC:          _____ Owner     _____ Land Developer     _____ Designer 
iii. Full Street Address:   _____ Owner     _____ Land Developer     _____ Designer 
iv. Phone Number:         _____ Owner     _____ Land Developer     _____ Designer 

19. _____ Include a Licensed Professional Certification that states “I hereby certify that this plan has 
been prepared under my supervision and to the best of my knowledge complies with the 
applicable state and local regulations and ordinances.”  This shall be signed in ink or an 
original reproducible. 

20. _____ Provide a list of all sheets and their corresponding sheet number for all Preliminary Sediment 
and Stormwater Management Plans.  
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Schematic Construction Site Stormwater Management Plans: 
The purpose of the Schematic Construction Site Stormwater Management Plan is to provide a preliminary 
design of the site’s phasing in relation to the site’s existing conditions and its construction and stormwater 
facility locations.  It will eventually be further developed into the Pre-Construction and Construction Site 
Stormwater Management Plan for the full plan submittal.    
21. _____ Schematic Pre-Construction Site Stormwater Management Plan (if required, as determined at 

the SAS review meeting): 
a. _____ Include the entire site boundary in an existing conditions plan view (i.e., site 

boundary, existing contours, wetlands, treelines, existing structures/utilities to 
remain or to be removed, etc). 

b. _____ Indicate the approximate limit of disturbance per phase of construction.  Provide a 
legend indicating the total disturbed acreage per limit of construction. 

c. _____ Indicate the location of all perimeter controls, stockpile locations, sediment 
trapping facilities, and other construction stormwater management controls 
needed for demolition and bulk grading (i.e., silt fence, stabilized construction 
entrances, temporary swales, sediment basins, etc).   

d. _____ Proposed contours are not required.   
e. _____ Provide a legend indicating the lines and symbols used to define the site and 

construction stormwater controls.   
22. _____ Schematic Construction Site Stormwater Management Plan: 

a. _____ Include the entire site boundary in an existing conditions plan view (i.e., site 
boundary, existing contours, wetlands, treelines, existing structures to remain, 
etc). 

b. _____ Include a preliminary site plan view overlaid with the existing conditions.  Include 
all lot and/or building outlines; right-of-ways and/or paved areas (whichever is less 
constrictive); and proposed stormwater locations including facilities, structures and 
pipes.   

c. _____ Indicate the approximate limit of disturbance per phase of construction.  Provide a 
legend indicating the total disturbed acreage per limit of construction. 

d. _____ Indicate the location of all construction site stormwater controls, including 
perimeter controls, sediment controls, water controls, and pollution prevention 
controls. (i.e., silt fence, stabilized construction entrances, temporary swales, 
sediment basins, etc).  Graphic symbols representing the practice can be utilized 
(ie, sediment basins do not need to be graded out).   

e. _____ Proposed contours are not required, but should be included when available.  If not 
flow arrows showing the drainage intent with sample spot elevations can suffice.     

f. _____ Provide a legend indicating the lines and symbols used to define the site and 
construction stormwater controls, corresponding to the current Delaware Erosion 
and Sediment Control Handbook.   
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Drainage Area Plans: 
The drainage area plans shall provide a graphic portrayal of the information that is contained within the 
DURMM worksheets.  .   
23. _____ Overall BMP Contributing Drainage Area Plan 

a. _____ Provide only for sites that cannot be shown in their entirety at the maximum scale 
of 1”=100’. 

b. _____ Provide the type and location of Stormwater BMP(s) including the BMP draingage 
area boundary. 

c. _____ Provide the total area of each sub-drainage area. 
d. _____ Provide a summary table indicating the sub-areas and their respective point of 

analysis, total area, and RCN.  
24. _____ BMP Contributing Drainage Area Plan 

a. _____ Provide a plan correlating to the Contributing Area RCN worksheet (post 
development model for the entire drainage area) for each subarea (subareas may 
be combined onto the same sheet, so long as they are clearly distinguishable).   

b. _____ Provide soils mapping on the plan, using the latest NRCS soil information, with a 
general description of each soil. 

c. _____ Indicate the LOD and the OLOD contributing areas, separated per their respective 
land cover and soil type classification.  Provide the area of each designation. 

d. _____ Provide a legend indicating the various land covers per soil type classification (a 
hatch shall be provided for each type of land cover; i.e. grass-B soils, impervious-
D soils).   

e. _____ Provide a summary table indicating the sub-areas and their respective point of 
analysis, total area, and RCN.   

f. _____ Indicate the location, type and sizing information for each BMP including a 
representative cross section. 

g. _____ Show the Tc path for the area outside the LOD as used in the OLOD worksheet. 
h. _____ Show the Tc path for any other areas that require further analysis using other H&H 

software.   
25. _____ Pre-Developed Subarea Limit of Disturbance Data Plan 

a. _____ Provide a plan correlating to the Pre-Developed LOD information requested in the 
LOD worksheet (location of woods/meadow and impervious conditions within the 
LOD per sub-area prior to disturbance) for each subarea (subareas may be 
combined onto the same sheet, so long as they are clearly distinguishable). 

b. _____ Provide soils mapping on the plan, using the latest NRCS soil information, with a 
general description of each soil. 

c. _____ Indicate the areas of woods/meadow and impervious condition per soil type 
classification.  Provide the area of each designation. 

d. _____ Provide a legend indicating the various land covers per soil type classification (a 
hatch shall be provided for each type of land cover; i.e. grass-B soils, impervious-
D soils).   

e. _____ Provide a summary table indicating the sub-areas and their respective point of 
analysis, total area, and RCN.   

26. _____ Any additional hydraulic or hydrologic computations that are required to show compliance with 
the Delaware Sediment and Stormwater Regulations may require additional drainage area or 
watershed plans (i.e., to satisfy the Cv and Fv requirements).  These plans are not prescribed, 
but shall follow similar guidelines, clearly indicate the parameters used within the calculations, 
and be contained within the plan Sediment and Stormwater Management Plan set. 
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Stormwater Management Report: 
27. _____ Provide information in the report in the following order: 

a. _____ Coverpage 
b. _____ Table of Contents 
c. _____ Site Narrative: 

i. _____ Introduction 
ii. _____ Existing Conditions describing the drainage patterns, landuse(s), and 

existing features. Include 2007 site aerial, 2007 Land Use Land Cover mapping, 
and photos of the site conditions and at all discharge locations.   

iii. _____ Existing Soils description per the NRCS Web Soil Survey including the 
hydrologic soil group; and soil testing results from on-site soil testing.   

iv. _____ Post Development Conditions, including summary of the proposed 
development, the proposed drainage system, indication of why the standards or 
performance approach was utilized, methods for RPv, Cv, and Fv compliance, 
requests for waivers and/or offsets, etc.   

v. _____ Construction Site Conditions, describing methods to prevent sediment and 
pollution discharge and illicit transportation.   

vi. _____ Conclusion 
(Note: It is not the objective to provide in depth information on practices that 
might change in the future due to the preliminary state of the submittal.  The 
narrative can be elaborated for future submittals once the design becomes 
finalized; however, the intent of the construction and post construction practices 
should be described, indicating how the site will be handled with any potential 
concerns documented.) 

d. _____ DURMM computations and a schematic of the drainage subareas and stormwater 
practices 

e. _____ Additional hydraulic and hydrologic computations, such as supporting calculations 
for either the standards or performance based approach for the Cv and Fv events.  
Detailed information subject to change 

f. _____ Supplementary Construction Site computations (i.e., temporary sediment basin 
sizing, anti-seep collar sizing, forebay sizing, etc).  [Provide place holder for future 
information; does not need to be included for Preliminary submittal].   

g. _____ Soil report(s) including boring locations and log reports. 
h. _____ Appendix containing any supplemental information (information previously 

included within the Stormwater Assessment Study report does not need to be 
duplicated).     

28. _____ Provide drainage calculations for the RPv, Cv, and Fv events using the latest DURMM model 
and other approved H&H software as required.   

29. _____ All inputted data must be supported by surveys, Lidar information, photos, aerials, maps, etc. 
and shall be referenced in the report and/or drainage area plans.   Information previously 
included within the Stormwater Assessment Study submittal is acceptable and does not need 
to be duplicated, though shall be referenced accordingly.     

30. _____ The storm duration for computational purposes shall be the 24-hour rainfall event, unless 
otherwise specified.  For projects south of the Chesapeake and Delaware (C&D) Canal, the 
Delmarva Unit Hydrograph shall be used.   

31. _____ The pre-development condition shall be based off of the 2007 aerial photography and the Land 
Use Land Cover overlay mapping provided by the State of Delaware, through Stormwater 
Assessment Study GIS Web Application.  This may not directly correlate to current site 
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conditions if the landuse has changed; however, the 2007 landuse shall be used regardless 
even if more or less conservative than the current landuse.   

32. _____ The pre-development condition shall be computed assuming that all existing land uses in the 
site that are to be developed are in good hydrologic condition. 

33. _____ Provide sizing information for the BMP(s) to be used and show they meet sizing guidelines 
according to section 3.06.2 Post Construction Stormwater BMP Standards and Specifications 
of the Technical Document. 

34. _____ Provide BMP capacity information for any detention practices to be used. 
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Preliminary Sediment & Stormwater Management Plan Review Checklist 
 
DATE RECEIVED: _________________________    PROJECT NUMBER: ______________________ 
 
PROJECT NAME: ____________________________________________________________________ 
 
 
General Information: 
1. _____ Completed application signed by the owner, review fee, one set of plans and reports, and a 

completed checklist must be submitted for review.  Electronic plan and report program files 
(i.e., AutoCAD, Microstation, DURMM, HydroCAD, and/or equal/similar) shall be transmitted 
upon agency request.   

2. _____ Provide a copy of the notice to DelDOT, a municipality, or a private entity (i.e., neighboring 
Homeowner’s Association) for the intent to discharge or connect to their stormwater system.  
The notice shall indicate the proposed condition and that any comments regarding the 
discharge shall be returned within 30 calendar days, and if no comments are received than 
consent to discharge is assumed.  If directly copied on the notice, indicate the date of the 
notice and the reviewer copied: _________________________________________________. 

3. _____ Hydraulic and Hydrology computations shall reflect the proposed site conditions.   
4. _____ All plans should be submitted on 24” x 36” (minimum) sheets unless otherwise approved. 
5. _____ When two (2) or more sheets are used to illustrate the plan view, an index sheet is required, 

illustrating the entire project on one (1) 24” x 36” (minimum) sheet. 
6. _____ Provide a north arrow on all plans. 
7. _____ Provide all plan views to a defined scale with a scale bar.   
8. _____ Provide names of adjacent property owners on all plans. 
9. _____ Provide existing and proposed contours (if provided) based on NAVD 88 vertical datum at one 

(1) foot intervals (2 foot intervals can be provided for offsite drainage information based on the 
latest Lidar information).   

10. _____ For small projects less than ½ acre of disturbance, provide existing and proposed spot 
elevations based on NAVD 88 vertical datum on a fifty-foot grid system.  Include high and low 
points.   

11. _____ Locate the site in NAD83 horizontal datum.   
12. _____ Provide the contact information for the person or entity responsible for preparing the plans and 

report, including name, company, address and telephone number.  Locate on both the plans 
and report. 

13. _____ Provide the seal of a Licensed Professional in the State of Delaware on all submitted plans 
and reports.    

14. _____ Provide the Preliminary Sediment and Stormwater Management plans in the following order 
and title.  The sheet list is to appear on the Coversheet, and on each plan sheet shall be 
respectively titled (include the title of the plan within the title block or lower righthand corner of 
the sheet): 
a. _____ Coversheet 
b. _____ Schematic Pre-Construction Site Stormwater Management Plan 
c. _____ Schematic Construction Site Stormwater Management Plan  
d. _____ Contributing Drainage Area Plan 
e. _____ Pre-Limit of Disturbance Drainage Area Plan 
f. _____ Post Limit of Disturbance Drainage Area Plan 
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Coversheet: 
15. _____ Project Header (to duplicate in the title block on each sheet): 

a. _____ Project Name (and Phase, if applicable). 
b. _____ Title of Plan Set: Preliminary Sediment and Stormwater Management Plans 
c. _____ Project Location (including watershed, hundred, town, county, etc., as applicable).   
d. _____ Project tax map identification number(s).   

16. _____ Legend indicating plan symbols and lines, including but not limited to, soils, drainage area 
information, grading and site information. 

17. _____ Provide a vicinity map with a scale either at 1” = ½ mile or 1” = 1 mile, depending on project 
size, and indicate the site boundary within the map.  The map shall be no smaller than 4”x4” in 
size.   

18. _____ Project Notes:  
a. Parcel Data: 

i. _____ Tax Map Number(s) 
ii. _____ PLUS Number (if applicable) 
iii. _____ DNREC Sediment and Stormwater Program [or relevant Delegated 

Agency] Number 
iv. _____ Site Address (or Nearest Intersecting Street and Distance between) 
v. _____ Latitude and Longitude State Plane coordinates, with approximate 

geographical location (ie, Benchmark #1, Northeast Site Corner, etc).  
Provide in degree decimal format. 

vi. _____ Existing Site Area 
vii. _____ Proposed Site Area 
viii. _____ Existing Wetland Area 
ix. _____ Proposed Discharge Location(s) 
x. _____ Proposed Total Limit of Disturbance per Discharge Location 

b. Contact Data: 
i. Owner’s Name, Title: _____ Owner     _____ Land Developer     _____ Designer 
ii. Company/LLC:          _____ Owner     _____ Land Developer     _____ Designer 
iii. Full Street Address:   _____ Owner     _____ Land Developer     _____ Designer 
iv. Phone Number:         _____ Owner     _____ Land Developer     _____ Designer 
v. Fax Number:              _____ Owner     _____ Land Developer     _____ Designer 

19. _____ Include a Site Designer Certification that states “I hereby certify that this plan has been 
prepared under my supervision and to the best of my knowledge complies with the applicable 
state and local regulations and ordinances.”  This shall be signed in ink or an original 
reproducible. 

20. _____ Provide a list of all sheets and their corresponding sheet number for all Preliminary Sediment 
and Stormwater Management Plans.  
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Schematic Construction Site Stormwater Management Plans: 
The purpose of the Schematic Construction Site Stormwater Management Plan is to provide a preliminary 
design of the site’s phasing in relation to the site’s existing conditions and it’s construction and stormwater 
facility locations.  It will eventually be further developed into the Pre-Construction and Construction Site 
Stormwater Management Plan for the full plan submittal.    
21. _____ Schematic Pre-Construction Site Stormwater Management Plan (if required, as determined at 

the SAS review meeting): 
a. _____ Include the entire site boundary in an existing conditions plan view (i.e., site 

boundary, existing contours, wetlands, treelines, existing structures/utilities to 
remain or to be removed, etc). 

b. _____ Indicate the approximate limit of disturbance per phase of construction.  Provide a 
legend indicating the total disturbed acreage per limit of construction. 

c. _____ Indicate the location of all perimeter controls, stockpile locations, sediment 
trapping facilities, and other construction stormwater management controls 
needed for demolition and bulk grading (i.e., silt fence, stabilized construction 
entrances, temporary swales, sediment basins, etc).   

d. _____ Proposed contours are not required.   
e. _____ Provide a legend indicating the lines and symbols used to define the site and 

construction stormwater controls.   
22. _____ Schematic Construction Site Stormwater Management Plan: 

a. _____ Include the entire site boundary in an existing conditions plan view (i.e., site 
boundary, existing contours, wetlands, treelines, existing structures to remain, 
etc). 

b. _____ Include a preliminary site plan view overlaid with the existing conditions.  Include 
all lot and/or building outlines; right-of-ways and/or paved areas (whichever is less 
constrictive); and proposed stormwater locations including facilities, structures and 
pipes.   

c. _____ Indicate the approximate limit of disturbance per phase of construction.  Provide a 
legend indicating the total disturbed acreage per limit of construction. 

d. _____ Indicate the location of all construction site stormwater controls, including 
perimeter controls, sediment controls, water controls, and pollution prevention 
controls. (i.e., silt fence, stabilized construction entrances, temporary swales, 
sediment basins, etc).  Graphic symbols representing the practice can be utilized 
(ie, sediment basins do not need to be graded out).   

e. _____ Proposed contours are not required, but should be included when available.  If not 
flow arrows showing the drainage intent with sample spot elevations can suffice.     

f. _____ Provide a legend indicating the lines and symbols used to define the site and 
construction stormwater controls, corresponding to the current Delaware Erosion 
and Sediment Control Handbook.   
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Drainage Area Plans: 
The drainage area plans shall provide a graphic portrayal of the information that is contained with the 
DURMM worksheets.  Any additional hydraulic or hydrologic computations that are required to show 
compliance with the Delaware Sediment and Stormwater Regulations may require additional drainage 
area or watershed plans (i.e., to satisfy the Cv and Fv requirements).  These plans are not prescribed 
below, but shall follow similar guidelines, clearly indicate the parameters used within the calculations, and 
be contained within the plan Sediment and Stormwater Management Plan set.   
23. _____ Contributing Drainage Area Plan 

a. _____ Provide a plan correlating to the Contributing Area RCN worksheet (post 
development model for the entire drainage area) for each subarea (subareas may 
be combined onto the same sheet, so long as they are clearly distinguishable).   

b. _____ Provide soils mapping on the plan, using the latest NRCS soil information, with a 
general description of each soil. 

c. _____ Indicate the LOD and the OLOD contributing areas, separated per their respective 
land cover and soil type classification.  Provide the area of each designation. 

d. _____ Provide a legend indicating the various landuse covers (a hatch shall be provided 
for each type of landuse).   

e. _____ Provide a summary table indicating the sub-areas and their respective point of 
analysis, total area, and RCN.   

f. _____ Show the Tc path for the area outside the LOD as used in the OLOD worksheet. 
g. _____ Show the Tc path for any other areas that require further analysis using other H&H 

software.   
24. _____ Pre-Limit of Disturbance Drainage Area Plan 

a. _____ Provide a plan correlating to the Pre LOD information requested in the LOD 
worksheet (location of woods and meadow condition within the LOD per sub-area 
prior to disturbance) for each subarea (subareas may be combined onto the same 
sheet, so long as they are clearly distinguishable). 

b. _____ Provide soils mapping on the plan, using the latest NRCS soil information, with a 
general description of each soil. 

c. _____ Indicate the areas of woods and/or meadow condition per soil type classification.  
Provide the area of each designation. 

d. _____ Provide a legend indicating the various landuse covers (a hatch shall be provided 
for each type of landuse).   

e. _____ Provide a summary table indicating the sub-areas and their respective point of 
analysis, total area, and RCN.   

25. _____ Post Limit of Disturbance Drainage Area Plan 
a. _____ Provide a plan correlating to the Post LOD information requested in the LOD 

worksheet (location of all impervious areas).  This should only be done if the LOD 
and OLOD cannot be shown on the Contributing Area Plan due to sizing.   

b. _____ Provide soils mapping on plan, using the latest NRCS soil information, with a 
general description of each soil. 

c. _____ Indicate the impervious area with the subarea.  Provide the area of each 
designation. 

d. _____ Provide a legend indicating the various landuse covers (a hatch shall be provided 
for each type of landuse).   

e. _____ Provide a summary table indicating the sub-areas and their respective point of 
analysis, total area, and RCN.   
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Stormwater Management Report: 
26. _____ Provide information in the report in the following order: 

a. _____ Coverpage 
b. _____ Table of Contents 
c. _____ Site Narrative: 

i. _____ Introduction 
ii. _____ Existing Conditions describing the drainage patterns, landuse(s), and 

existing features. Include latest site aerial, latest Land Use Land Cover mapping, 
and photos of the site conditions and at all discharge locations.   

iii. _____ Existing Soils description per the NRCS Web Soil Survey including the 
hydrologic soil group; and soil testing results from on-site soil testing.   

iv. _____ Post Development Conditions, including summary of the proposed 
development, the proposed drainage system, indication of why the standards or 
performance approach was utilized, methods for RPv, Cv, and Fv compliance, 
requests for waivers and/or offsets, etc.   

v. _____ Construction Site Conditions, describing methods to prevent sediment and 
pollution discharge and illicit transportation.   

vi. _____ Conclusion 
(Note: It is not the objective to provide in depth information on practices that 
might change in the future due to the preliminary state of the submittal.  The 
narrative can be elaborated for future submittals once the design becomes 
finalized; however, the intent of the construction and post construction practices 
should be described, indicating how the site will be handled with any potential 
concerns documented.) 

d. _____ DURMM computations and a schematic of the drainage subareas and stormwater 
practices 

e. _____ Additional hydraulic and hydrologic computations, such as supporting calculations 
for either the standards or performance based approach for the Cv and Fv events.  
Detailed information subject to change 

f. _____ Supplementary Construction Site computations (i.e., temporary sediment basin 
sizing, anti-seep collar sizing, forebay sizing, etc).   

g. _____ Soil report(s) including boring locations and log reports. 
h. _____ Appendix containing any supplemental information (information previously 

included within the Stormwater Assessment Study report does not need to be 
duplicated).     

27. _____ Provide drainage calculations for the RPv, Cv, and Fv events using the latest DURMM model 
and other approved H&H software as required.   

28. _____ All inputted data must be supported by surveys, Lidar information, photos, aerials, maps, etc. 
and shall be referenced in the report and/or drainage area plans.   Information previously 
included within the Stormwater Assessment Study submittal is acceptable and does not need 
to be duplicated, though shall be referenced accordingly.     

29. _____ The storm duration for computational purposes shall be the 24-hour rainfall event, unless 
otherwise specified.  For projects south of the Chesapeake and Delaware (C&D) Canal, the 
Delmarva Unit Hydrograph shall be used.   

30. _____ The pre-development condition shall be based off of the 2007 aerial photography and the Land 
Use Land Cover overlay mapping provided by the State of Delaware, through various online 
GIS mapping services.  This may not directly correlate to current site conditions if the landuse 
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has changed; however, the 2007 landuse shall be used regardless even if more or less 
conservative than the current landuse.   

31. _____ The pre-development condition shall be computed assuming that all existing land uses in the 
site that are to be developed are in good hydrologic condition. 
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Procedure for Conducting Hydrologic & Hydraulic Analyses 
For Preliminary Sediment & Stormwater Plans  

 
Background 
 
The Hydrologic & Hydraulic (H&H) Analysis couples field collected data with 
desktop watershed modeling methodology to provide a tool for stormwater 
management agencies to help determine the most appropriate method to 
manage stormwater runoff from developing sites based on “No Adverse Impact” 
principles.  The general approach is one of increasing level of detail and analysis 
depending on the complexity of the watershed.  It is NOT intended to be a 
substitute for detailed Watershed Master Plans that have been endorsed by the 
Department.  When such detailed plans are available, the peak discharge and/or 
volume management requirements from the Watershed Master Plan shall take 
precedence over the requirements of the Level 2 Analysis.  Additionally, the 
methodologies used for this analysis are not considered to be precise enough to 
be applied at the site level. 
 
Procedure    

 
1. Applicability 

1.1. The H&H analysis will be required for all projects using the performance-
based option and/or where a sump condition exists. 

2. Methodology 
2.1. Level 1 Analysis   

2.1.1. The Level 1 Analysis combines field reconnaissance data with 
hydrologic modeling of the upstream watershed and site using latest 
soils, LULC, and terrain data.  Hydrographs are then compared to 
check for coincidental peaking effects. 

2.1.2. Limit of study shall be the most-downstream junction of the site and 
the upstream contributing area. 

2.1.3. To comply at this level of analysis, hydrologic modeling must 
indicate no adverse impact due to coincidental peaking effects.  For 
purposes of this policy, “no adverse impact” shall mean that the 
developed site hydrograph peak is less than, and the inflection point 
occurs before, the peak of the upstream hydrograph OR that it can be 
demonstrated that on-site detention would exacerbate downstream 
impacts.  If compliance cannot be demonstrated, proceed to Level 2. 

2.2. Level 2 Analysis 
2.2.1. The Level 2 Analysis combines field measurement data with 

hydraulic modeling of structures, channels, etc. using an expanded 
hydrologic model. 
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2.2.2. Limit of the study shall be the point downstream where the site is 
10% of the total contributing drainage area.  Points of Analysis 
(POAs) shall be established at the site boundary and all hydraulic 
structures within the study reach.  In cases where there are no 
hydraulic structures within the study reach, representative section(s) 
based on LiDAR data shall be used; locations to be determined at the 
Project Application Meeting. 

2.2.3. To comply at this level of analysis, the applicant must show that: 
2.2.3.1. The runoff volume based on the NRCS Runoff Curve 

Number (RCN) and the rate of runoff based on the calculated 
peak discharge for the post-developed condition does not 
exceed that for the pre-developed condition, or; 

2.2.3.2. Steady flow hydraulic modeling must indicate no adverse 
impacts to headwater, water surface elevations and/or areas of 
inundation at designated POAs.  For purposes of this policy, “no 
adverse impact” shall mean less than 0.05’ increase in the 
calculated water surface elevations in channels and/or in 
headwater at hydraulic structures for all points of analysis.  In 
addition, the area of inundation shall not encroach upon 
buildings or similar structures previously not impacted.  If the “no 
adverse impact” condition can not be met, a remedy must be 
provided in accordance with Section 3 of this policy.  If impacts 
are uncertain, proceed to Level 3. 

2.3. Level 3 Analysis 
2.3.1. The Level 3 Analysis shall be used in situations in which the 

watershed is so complex that a more rigorous analysis is needed to 
determine the appropriate stormwater management technique(s).  It 
is expected that this would require survey-level field data to support 
development of an unsteady flow model.  This may also require 
accounting for existing storage structures within the watershed study 
area. 

2.3.2. Limit of the study shall be the point downstream where the site is 
10% of the total contributing drainage area.  POAs shall be 
established at the site boundary and all hydraulic structures within the 
study reach.  In cases where there are no hydraulic structures within 
the study reach, representative section(s) based on LiDAR data shall 
be used; locations to be determined at Project Application Meeting. 

2.3.3. To comply at this level of analysis, unsteady flow hydraulic 
modeling must indicate no adverse impacts to headwater, water 
surface elevations and/or areas of inundation at designated POAs.  
For purposes of this policy, “no adverse impact” shall mean less than 
0.05’ increase in water surface elevations in channels and/or in 
headwater at hydraulic structures for all points of investigation. In 
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addition, the area of inundation shall not encroach upon buildings or 
similar structures previously not impacted.  If the “no adverse impact” 
condition cannot be met, a remedy must be provided in accordance 
with Section 3 of this policy. 

3. Remedy 
3.1. Option 1: Modify detention design so that the downstream condition 

meets the “no adverse impact” as defined in Section 2 of this policy. 
3.2. Option 2: Improve existing downstream conveyance system so that the 

downstream condition meets the “no adverse impact” defined above. 
3.2.1. Design criteria under this option shall be established by the 

appropriate review/approval authority (see “Scenario Matrix”).  In 
general, structures within a DelDOT ROW must meet the design 
criteria of the DelDOT Road Design and/or Bridge Design Manuals.  
Modifications to a Tax Ditch must meet the design criteria of 
DNREC/Drainage and approved by the appropriate Tax Ditch 
Organization.  All other proposed modifications to an existing 
conveyance system or on-site stormwater management facility shall 
be reviewed on a case-by-case basis by DNREC or its authorized 
agent. 
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Workflow for Performing Level 1 H&H Analysis 

1. Part 1 – Watershed Delineation 

1.1.   Use procedures from “Workflow Site Hydrology” document to delineate all watersheds 
draining to the site discharge Point of Analysis  (POA) 

2. Part 2 –HEC-HMS Analysis 

2.1.   Open “HH1_Analysis.hms”  template file 

2.2.   Save As “Projectname.hms”  (If an error occurs, close HEC-HMS and re-open 
“Projectname.hms” in the newly created “Project name” directory.) 

2.3.   In Watershed Explorer window,  expand “Basin Models”  and click on “Project”; template 
basin model will open in the Desktop window 

2.4.  Left-click “Upstream” subbasin icon; subbasin parameters will open in the Component Editor 
window 

2.4.1.   Subbasin tab:  

2.4.1.1. Enter watershed area in sq. miles as determined in Part 1 

2.4.1.2. Loss Method: SCS Curve Number 

2.4.1.3. Transform Method:  SCS Unit Hydrograph 

2.4.2.   “Loss” tab:  

2.4.2.1. Enter Curve Number for upstream watershed 

2.4.2.2. Leave remaining fields set to their default values 

2.4.3.   “Transform” tab: 

2.4.3.1. Select “Standard” or “Delmarva” from Graph Type dropdown list 

2.4.3.2. Enter Lag Time in minutes (Lag = 0.6Tc) as used in GISHydro TR-20 run 

2.5.   Repeat Step 2.4 for “Site” subarea(s) using data for post-developed condition based on the 
DURMM v.2 analysis.  (NOTE: If the site consists of multiple subareas, they should be 
combined at the site POA.)  

2.6.   Click on the “Compute” tab at the bottom of the Watershed Explorer window; expand 
“Simulation Runs” 
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2.7.   Select the appropriate pre-formatted storm event for the simulation run 

2.8.   Click the “Compute Current Run” button on the toolbar 

 

2.9.   If all the data has been entered correctly, a progress bar will appear showing 100% 
completion.  Error messages will be shown in red in the Message Log window. 

2.10.   Right-clicking on the various hydrologic elements will reveal a fly-out menu with 
options for viewing results;  as an alternative, opening the project DSS file in HEC-DSSVue 
will allow more options for viewing the results. 

3. Part 3 – Compliance Check 

3.1.   Determine the Time of Peak (Tp) for the Upstream subarea hydrograph 

3.2.   Determine the Time of Inflection Point (Tinf) for the combined site subarea hydrograph 

3.2.1.   The Tinf can be determined from the Time of Concentration (Tc) as follows: 

3.2.1.1. Std. UH:  Tinf = 0.4665 Tc 

3.2.1.2. DMV UH:  Tinf = 0.5665 Tc 

3.3.   A site is considered in compliance if the site Tinf < Tp of the upstream hydrograph. 
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Workflow for Performing Level 2 H&H Analysis 

The following procedure is based on what is considered the minimum requirements for the Level 2 
H&H Analysis, which involves determining the water surface elevation for the pre-developed and 
post-developed conditions at the point of discharge from the site.  The hydraulic model consists of 
three (3) cross sections.  The middle cross section is established immediately downstream from 
the site discharge point.  A minimum of one cross section upstream and one cross section 
downstream must be used to ensure the model will yield reasonable results.  It may be necessary 
to analyze additional sections downstream to the “10% Rule” POA based on current Departmental 
guidance and/or policy. 

1. Part 1 – Watershed Delineation 

1.1.   Use procedures from “Workflow Site Hydrology” document to delineate all watersheds 
draining to the Point of Analysis  (POA) based on the “10% Rule”. 

2. Part 2 –HEC-HMS Analysis 

2.1.  Open “HH2_Analysis.hms”  template file 

2.2.  Save As “Projectname.hms”  (If an error occurs, close HEC-HMS and re-open 
“Projectname.hms” in the newly created “Project name” directory. 

2.3.  Use procedures from “Workflow H&H Level 1 Analysis” to develop a watershed model for 
both the “pre-developed” site condition and the “post-developed” site condition to the POA 
from Part 1.  

3. Part 3 – HEC-RAS Analysis 

3.1. Create HEC-RAS Project: File>New Project 
3.2.  Click “Edit/Enter geometry data” button or: Edit>Geometric Data 

 
3.2.1.  Switch to Geometric Data workspace window 
3.2.2.  Create new river segment 

3.2.2.1. Click on the “River Reach” button and sketch a river segment; double-click to 
complete sketch (NOTE: When sketching the river segment, the model assumes 
the initial starting point is the most upstream point for the analysis.) 

3.2.2.2. Enter “River” and “Reach” names in pop-up window 
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3.2.3.   Add cross section data 
3.2.3.1. Click on the “Cross Section” button from the vertical tool bar on the left 
3.2.3.2. Switch to Cross Section Data workspace window 
3.2.3.3. Add new cross-section data: Options>Add a new Cross Section 
3.2.3.4. Enter river station for the most upstream section in pop-up window  (NOTE:  

Although HEC-RAS will automatically place cross-sections on the river sketch 
based on the river station, it is considered best practice to enter the cross section 
data starting at the most upstream station and proceeding in a  downstream 
direction.) 

3.2.3.5. Enter cross section station and corresponding elevation in the appropriate cells in 
the “Cross Section Coordinates” section.    

3.2.3.6. Enter the distances to the next downstream section for the left overbank, channel 
centerline and right overbank in the “Downstream Reach Lengths” section.  
(NOTE: Enter “0” values for the final downstream section.) 

3.2.3.7. Enter Manning’s n values for the left overbank, channel and right overbank in the 
“Manning’s n Values” section 

3.2.3.8. Enter the stations corresponding to the left bank and right bank in the “Main 
Channel Bank Stations” section 

3.2.3.9. Accept the default values for the contraction and expansion coefficients 
3.2.3.10. Once all the data has been entered, click the “Apply Data” button; cross section 

data will automatically be plotted 
3.2.3.11. Repeat process from Step 3.2.3.3 for remaining cross sections. 
3.2.3.12. Exit Cross Section Data workspace window and return to Geometric Data 

workspace window 
3.2.4. Save: File>Save Geometry Data 
3.2.5. Name geometry data file in pop-up window 
3.2.6. Close and return to main HEC-RAS window 

3.3. Prepare steady flow data 
3.3.1. Click “Edit/Enter steady flow data” button or: Edit>Steady Flow Data 

 

3.3.2. Switch to Steady Flow Data workspace window 
3.3.2.1. Select appropriate River and Reach from drop-down lists 
3.3.2.2. Enter number of flow profiles: “2” 
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3.3.2.2.1. Profile 1:  Pre-developed condition 
3.3.2.2.2. Profile 2: Post-developed condition 

3.3.2.3. Click “Apply Data” button 
3.3.2.4. Click “Reach Boundary Conditions” button 

3.3.2.4.1. Select “Set boundary for all profiles” or “Set boundary for one profile at a 
time” 

3.3.2.4.2. For subcritical flow, select appropriate “Downstream” boundary condition 
(NOTE:  Typically the “Normal Depth” condition is used; the downstream 
slope is then entered in the pop-up window.) 

3.3.2.4.3. For supercritical flow, select appropriate “Upstream” boundary condition 
3.3.2.5. Click “OK” to return to Steady Flow Data workspace 
3.3.2.6. “RS” station will automatically be set at most upstream station to enter initial flow 

data 
3.3.2.7. Enter flow data from HEC-HMS analysis from Part 2 in appropriate “PF” window; 

at least one flow must be entered for each reach 
3.3.2.7.1. Enter peak discharge for pre-developed condition in “PF1” cell 
3.3.2.7.2. Enter peak discharge for the post-developed condition in the “PF 2” cell 

3.3.2.8. Option:  If flow increases at downstream section(s), enter new flow data as 
necessary 

3.3.2.8.1. Select appropriate river and reach from drop-down list 
3.3.2.8.2. Select cross-section where flow changes from “River Sta.” drop-down list 
3.3.2.8.3. Click “Add A Flow Change Location” button 
3.3.2.8.4. Enter new flow in the appropriate profile cell 

3.3.2.9. Click “Apply Data” button 
3.3.2.10. Save: File>Save Flow Data 
3.3.2.11. Name flow data file in pop-up window 

3.3.3. Close and return to main HEC-RAS window 
3.4. Prepare to run HEC-RAS 

3.4.1. Click “Perform a steady flow simulation” button or: Run>Steady Flow Analysis 

 

3.4.2. Switch to Steady Flow Analysis workspace window 
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3.4.2.1. Create new plan file: File>New Plan 
3.4.2.1.1. Name plan file in pop-up window 
3.4.2.1.2. Enter short name identifier when prompted 

3.4.2.2. Select Geometry File from drop-down list 
3.4.2.3. Select Steady Flow File from drop-down list 
3.4.2.4. Save: File>Save Plan 
3.4.2.5. Click “Compute” button 

3.5.  Analyze HEC-RAS Results  
3.5.1. Click the “View profiles” button (NOTE: To view results for multiple profiles, click the 

“Profiles” button; check profiles to be viewed.) 

 

3.5.2. Click the “View cross sections” button 

 

3.5.3.  Click the “View summary output tables by profile” button 

  

4. Part 4 – Compliance Check 
4.1. Compare the “W.S. Elev” values for the pre-developed profile and the post-developed profile 

for the POA section and downstream section from the Profile Output Table 

4.2.  A site is considered in compliance if the difference in water surface elevations at these cross 
sections is < 0.05’ 
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Introduction

This document has been developed to illustrate the Unit Discharge Methodology to meet the
standards-based quantity management requirements of the Delaware Sediment & Stormwater
Regulations (DSSR).

NOTE: Only those projects that receive all “Minor” ratings on the Stormwater Assessment Report
(SAR) qualify for the Unit Discharge Methodology.  This document was created using an
earlier version of DURMM v2.  Although some of the screen shots do not exactly match the
latest version, the procedures remain the same.

Delaware 
Sediment & Stormwater

Regulations:
Proposed Quantity Management 

Methodology

“Broadkill Estates”
Unit Discharge Example

Draft 09/2010
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Background

This example builds on the results from the Delaware Urban Runoff Management Model
(DURMM) analysis of the fictional “Broadkill Estates” for the Resource Protection Event as
illustrated in the DURMM v.2 Quick-Start Guide.  The site is bisected by a tributary stream that
runs from south to north.  This site drainage is therefore characterized by a west drainage
subarea and an east drainage subarea.  For the purposes of this example, the proposed lot
and road layout for the east drainage subarea will be analyzed.  The area outside the lots will
be designated as common open space.

“Broadkill Estates” Example Site

West

Drainage

East
Drainage

03/2013 3.02.2.6-2



3 Draft 09/2010

Data Inputs – “C.A. RCN” Worksheet

The slide above summarizes the data inputs for the “C.A. RCN” worksheet used for the
DURMM v.2 analysis.

Unit Discharge Example
East Drainage: Site Data

• C.A. RCN Tab
– 1-ac. residential (20 % imperv.)

• HSG A: 21.17 ac.
• HSG B: 0.73 ac

– Open space
• HSG A: 8.06 ac.
• HSG B: 2.26 ac

– Row Crops, SR + Crop Residue 
• HSG A: 9.68 ac. 
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Data Inputs – “LOD” Worksheets

The slide above summarizes the data inputs for the “LOD” worksheet.

Unit Discharge Example
East Drainage: Site Data (cont.)

• LOD Tab
– HSG A

• LOD area: 29.22 ac.
• Pre-Dev. Woods: 1.55 ac.
• Post-Dev. Impervious: 4.23 ac.

– HSG B
• LOD area: 2.99 ac.
• Pre-Dev. Woods: 0 ac.
• Post-Dev. Impervious: 0.15 ac.
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Data Inputs – “OLOD” Worksheets

The slide above summarizes the data inputs for the “OLOD” worksheet.

NOTE: The Time of Concentration (Tc) calculations for the area outside the LOD indicated a
relatively long flow time of 0.98 hours from the DURMM v.2 analysis.  This flow time
should not necessarily be used to represent the Tc for the developed site condition,
however, for quantity management purposes.  In this case, the majority of the flow
will be generated by the lots and roadway.  The Tc for this portion of the site was
calculated to be 0.2 hours.  Since this Tc is deemed to be more representative of the
majority of the runoff volume contained in the hydrograph, it should therefore be
used as the Tc for the East Drainage subarea for subsequent quantity management
calculations.

Unit Discharge Example
East Drainage: Site Data (cont.)

• OLOD Tab
– Sheet Flow, 100 ft, 0.001 ft/ft, “d”
– Shallow Conc., 300 ft, 0.002 ft/ft, “u”
– Open Channel, 1000 ft, 0.01 ft/ft, 1.0 fps
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Unit Discharge Example
Conveyance Event (Cv)

Unit Discharge Example for Conveyance Event (Cv)

The Unit Discharge methodology will initially be illustrated for the Conveyance Event (Cv).
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Unit Discharge Example
DURMM Report

DURMM Report

The results from the DURMM v.2 analysis will provide the necessary data for the analysis.

03/2013 3.02.2.6-7



8Draft 09/2010

DURMM Report

The highlighted lines from the DURMM Report indicate:

Contributing Area to BMPs: 41.9 ac.
Adjusted RCN for Cv: 49.86

The adjusted RCN reflects the benefit of using runoff reduction techniques to comply with the
requirements of the DSSR for the Resource Protection Event (RPv).

Unit Discharge Example
East Drainage: TR-55 Data
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Unit Discharge Example 
East Drainage: TR-55 Data

• Drainage Area: 41.9 ac.
• Adjusted RCNCv : 50
• Tc: 0.2 hrs

TR-55 Site Data

This information is then used as input to a hydrologic analysis software package.  In this case,
WinTR-55 was used.  Typically, the RCN is rounded off to the nearest whole number.  Also
note that the Tc for the developed portion of the site was used for reasons cited earlier.
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TR-55 Storm Data

The 10-YR rainfall is input in the WinTR-55 “Storm Data” sheet.

Unit Discharge Example
East Drainage: TR-55 Data

• RainfallCv : 5.3 in.
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TR-55 Results

Once the user invokes the “Run” function, WinTR-55 calculates the 10-YR peak discharge.
Results can then be shown either graphically or in a text report as shown above.

Unit Discharge Example 
East Drainage: TR-55 Data

• PeakCv: 23.02 cfs
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Unit Discharge Example
Conveyance Event (Cv)

• Computed: 23.02 cfs
• Allowable: 28.29 cfs

Computed < Allowable

Compliance Check for Cv

The DURMM Report also contains the information necessary to determine whether the site
complies with the requirements of the DSSR for the Conveyance Event (Cv).  The highlighted
line from the report shows the allowable unit discharge as calculated in the DURMM v.2
analysis was 28.29 cfs for the Conveyance Event.  Since the 10-YR peak discharge of 23.02
cfs as calculated in WinTR-55 is less than the allowable discharge, the site complies with the
DSSR for the Conveyance Event.  In this case, meeting the requirements for the Resource
Protection Event (RPv) provided enough reduction in the runoff volume for the 10-YR storm
that no additional quantity management was needed.
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Check Compliance for 
Flooding Event (Fv)

Compliance Check for Fv

The next step is to check to see if the site complies with the requirements of the DSSR for the
Flooding Event (Fv).

03/2013 3.02.2.6-13



14Draft 09/2010

Unit Discharge Example
East Drainage: TR-55 Data

DURMM Report

The procedure is analagous to that for the Cv.  The highlighted lines from the DURMM Report
indicate:

Contributing Area to BMPs: 41.9 ac.
Adjusted RCN for Cv: 51.07

Note that DURMM v.2 has calculated a higher adjusted RCN for the Flooding Event since the
runoff reduction techniques used for the RPv are less effective for a storm of this magnitude.
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Unit Discharge Example
East Drainage: TR-55 Data

• Drainage Area: 41.9 ac.
• Adjusted RCNFv : 51
• Tc: 0.2 hrs

TR-55 Site Data

The drainage area, adjusted RCN and Tc are entered into WinTR-55.
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Unit Discharge Example
East Drainage: TR-55 Data

• RainfallFv : 9.2 in.

TR-55 Storm Data

The 100-YR rainfall is input in the WinTR-55 “Storm Data” sheet.
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Unit Discharge Example
East Drainage: TR-55 Data

• PeakFv: 119.66 cfs

TR-55 Results

Once the user invokes the “Run” function, WinTR-55 calculates the 100-YR peak discharge.
Results can then be shown either graphically or in a text report as shown above.
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Compliance Check for Fv

The DURMM Report also contains the information necessary to determine whether the site
complies with the requirements of the DSSR for the Flooding Event (Fv).  The highlighted line
from the report shows the allowable unit discharge as calculated in the DURMM v.2 analysis
was 84.99 cfs for the Flooding Event.  Since the 100-YR peak discharge of 119.66 cfs as
computed in WinTR-55 is greater than the allowable discharge, the site does not comply with
the DSSR for the Flooding Event.

Unit Discharge Example
Flooding Event (Fv)

• Computed: 119.66 cfs
• Allowable: 84.99 cfs

Computed > Allowable
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Unit Discharge Example
Flooding Event (Fv)

Management for Fv

Since the calculations indicate the site does not comply with the requirements of the DSSR for
the Flooding Event, additional management measures must be provided.  For storms of this
magnitude, detention storage is a typical solution.  Figure 6-1 from the TR-55 Manual can be
used to estimate the required storage volume.
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Unit Discharge Example
Flooding Event (Fv)

• qo = 85 cfs
• qi = 120 cfs
• qo/qi = 0.71
• Vs/Vr = 0.21

Estimating Required Storage Volume for Fv

1. Calculate “qo/qi” by dividing the allowable discharge determined in the DURMM v.2
analysis by the 100-YR peak discharge as determined in the WinTR-55 analysis.

2. Read up from the “qo/qi” value on the x-axis of Figure 6-1 to the intersection with the “Type
II and III” curve.

3. Read the “Vs/Vr” value off the y-axis of Figure 6-1.
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Unit Discharge Example
Flooding Event (Fv)

• Vs/Vr = 0.21
• Vr = 3.33 in.
• Vs = (0.21)(3.33) 

= 0.70 in.
= (0.06 ft)(41.9 ac)
= 2.4 ac-ft

Estimating Required Storage Volume for Fv (cont.)

Refer to the highlighted line in the DURMM Report to determine the runoff volume (Vr) for the
100-YR storm event.  Multiply this number by the “Vs/Vr” value determined from TR-55, Figure
6-1 to calculate the required storage (Vs) in watershed inches.  This value can then be
converted to feet and multiplied by the watershed drainage area to determine the required
storage in acre-feet.  Although this procedure generally provides satisfactory results, it is only
an estimate.  Full compliance must be verified through an actual routing of the storage facility.

NOTE: Figure 6-1 from the TR-55 Manual was developed for the NRCS Standard Unit
Hydrograph.  Although NRCS apparently developed a separate curve for the
Delmarva Unit Hydrograph which calculates a slightly lower “Vs/Vr” value, it is not
well documented.  Since the final design requires a routing to verify compliance, it is
recommended that Figure 6-1 be used for estimating storage volume with the
understanding that the results may be more conservative for the Delmarva Unit
Hydrograph.
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3.02.3 
Step 3: Sediment and Stormwater Management Plan 
 
The Sediment and Stormwater Management Plan submitted at Step 3 of the plan review 
and approval process shall include detailed information on the measures to control both 
sediment and non-sediment pollutants during the active construction phase as well as 
those measures to manage post-construction stormwater.  The Sediment & Stormwater 
Management Plan shall be submitted only after the Preliminary Sediment & Stormwater 
Management plan has been approved by the Delegated Agency.  

If significant changes have been made to the site development plan, the Delegated 
Agency may require the applicant to re-submit a Preliminary Sediment & Stormwater 
Management Plan prior to reviewing the Sediment & Stormwater Management Plan.   

Unless granted prior approval by the Delegated Agency, the Sediment & Stormwater 
Management Plan shall be developed as a “stand alone” plan independent of other site 
construction plans.  It shall consist of the following elements: 

1. Updated Stormwater Management Report and Drainage Area Plans 

2. Construction Site Stormwater Management Plan 

3. Post Construction Stormwater Management Plan 

The submittal shall be accompanied by a completed Sediment and Stormwater 
Management Plan Checklist (see 3.02.3.1). Refer to the Checklist for all required 
information; the below is a brief overview.  A standardized Sediment and Stormwater 
Plan coversheet is included in 3.05.2 and an example Sediment & Stormwater 
Management Plan is included as 3.02.3.2. 

The submittal package shall be reviewed for completeness by the Delegated Agency.  
Incomplete submittals will be returned in whole with the missing checklist items 
highlighted. 

The Sediment and Stormwater Management Plan shall include the following elements: 

1. Coversheet including the Standard Sediment and Stormwater Construction 
Notes, Project Notes, Owner’s Certification, Site Designer’s Certification, Vicinity 
Map, and other basic site information. 

2. Construction Site Stormwater Management Plans including a Phasing Plan, Pre-
Construction Plans, and Construction Plans, which show detailed information on 
the location, grading and construction data for all proposed Erosion and 
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Sediment Control practices.  A legend using the symbols from the current 
Delaware Erosion and Sediment Control Handbook (3.06.1) must be included.  
When more than one detailed sheet is needed to depict the information, an 
Overall plan showing the site and the construction practices shall be provided.   

3. Construction Site Details and Notes, including a Sequence of Construction, 
details for all proposed ESC practices, Construction Site Pollution Control details, 
and details of temporary and permanent stabilization measures. 

4. Post Construction Stormwater Management Plans, showing the construction and 
maintenance details for all stormwater facilities. 

5. Updated Stormwater Management Report and Drainage Area Plans per the 
Preliminary requirements. 

6. A copy of the project’s Site Plan, Grading Plan, and Record Plan.   

 

Coversheet 

The Coversheet for the Sediment and Stormwater Management Plan set shall contain 
basic site information to get a feel for the site’s location, size, and proposed conditions 
by providing information in the Project Header, Project Notes and a Vicinity Map.  The 
Coversheet should contain owner, developer (if different than the owner), designer and 
agency contact information, with areas designated for each entity’s certification (or 
approval block in case of the agency).  A wetland certification shall also be included for 
the site’s determined during the Stormwater Assessment Study as needing a wetland 
delineation.   

Standard Sediment and Stormwater Construction Notes shall be located on the 
Coversheet, in order to provide consistency between all projects throughout the state.  
Refer to the Sediment and Stormwater Plan Checklist (3.02.3.1) and the Example 
Coversheet (3.05.2) for the Standard Notes as required by the Department (note, each 
Delegated Agency may adopt additional Standard Notes).    

In addition to the project information and the standardized notes, the coversheet should 
also include a list of all the plan sheets within the set and their corresponding sheet 
number, and a standardized legend of site features and linetypes (note, a legend 
specific to the erosion and sediment controls is also required for the Construction Site 
Stormwater Management Plans; see below). 
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Construction Site Stormwater Management Plans 
The Schematic Construction Site Stormwater Management from the Preliminary 
submittal is elaborated to include detailed design information on the practices that will 
be utilized to safeguard the site’s construction against sediment and erosion, as well 
general construction pollution.  There are five types of plans that should be incorporated 
into the Construction Site Stormwater Management Plans, all evolving from the initial 
Schematic: 

1. Overall Construction Site Phasing Plan: For sites that have more than one 
construction phase, indicates the extents of each phase of construction on a 
site plan view with the total disturbed area of each phase noted.   

2. Overall Pre-Construction Site Stormwater Management Plan: For sites that 
cannot be shown in their entirety at the maximum scale of 1”=100’, provides 
one sheet that depicts the entire project’s existing conditions with the 
demolition and bulk grading controls indicated.  Matchlines refer to the 
location of the detailed sheets.  For small project’s without massive 
earthwork, this requirement may be waived at the Project Application 
Meeting.   

3. Pre-Construction Site Stormwater Management Plan: Provides detailed plan 
views at the maximum scale of 1”=100’ of the site’s existing conditions with 
design information for all of the demolition and bulk grading controls.  For 
small project’s without massive earthwork, this requirement may be waived at 
the Project Application Meeting.   

4. Overall Construction Site Stormwater Management Plan: For sites that cannot 
be shown in their entirety at the maximum scale of 1”=100’, provides one 
sheet that depicts the entire project’s proposed grading and site features with 
the erosion, sediment and pollution controls indicated.  Matchlines refer to the 
location of the detailed sheets.   

5. Construction Site Stormwater Management Plan: Provides detailed plan 
views at the maximum scale of 1”=100’ of the project’s proposed grading and 
site features with design information for all of the erosion, sediment and 
pollution controls.   

 
Reference the Sediment and Stormwater Plan Checklist (3.02.3.1) for specific 
information that should be contained within the Construction Site Stormwater 
Management Plans.  The plans sheets shall contain a legend for the symbols and 
linetypes used to represent the control practices used on-site; these symbols and 
linetypes shall be per the latest edition of the Delaware Erosion and Sediment Control 
Handbook.   
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In addition to the Construction Site plan view sheets, Construction Site Details and 
Notes are to be incorporated to provide additional design and construction information 
for the site’s controls.  The corresponding details for all practices used for sediment, 
erosion and pollution control within the site shall be included.  The detail shall be from 
the latest version of the Delaware Erosion and Sediment Control Handbook, unless an 
alternative detail has been approved.  The required design data for the detail shall be 
provided within the detail itself, or a note should be included to refer to the relevant 
chart for the information.    
 
Also included with the details, is be the Sequence of Construction, which should be a 
step by step order of operation for the initiation, construction and termination of a site’s 
construction, highlighting the erosion, sediment and pollution controls and the any 
phasing.  The Sequence of Construction shall, at a minimum, include the following 
activities:  

1. Pre-construction meeting 

2. Clearing and grubbing for those areas necessary for installation of perimeter 
controls;  

3. Construction of perimeter controls;  

4. Remaining clearing and grubbing;  

5. Road grading;  

6. Grading for the remainder of the site;  

7. Utility installation;  

8. Stormwater facility construction; 

9. Final grading, landscaping, or stabilization; and  

10. Removal of sediment controls. 

Specific Sequence of Construction items are to be included and are referred to in the 
Sediment and Stormwater Plan Checklist (3.02.3.1) and the typical Sequence of 
Construction (3.05.1). 
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Post Construction Stormwater Management Plans  

A separate plan sheet shall be provided for each individual stormwater management 
facility, in order to clearly depict the design and construction of the facility, and outline 
the future operation and maintenance requirements.  The plan sheet shall include, but 
not be limited to: 

1. Plan view showing proposed grading 

2. Section view with proposed elevations 

3. Details for any appurtenances 

4. Planting and/or stabilization information 

5. Sequence of construction 

6. Operation and Maintenance notes  

The Post Construction Stormwater Management facility construction detail sheet will 
serve as the foundation for the future Operation and Maintenance Plan for each 
stormwater management BMP, in combination with the Post Construction Verification 
Document.  The elements of the Operation and Maintenance Plan required at the Post 
Construction Stormwater Management Plan stage, along with all other Post 
Construction Plan requirements, can be found in the Sediment and Stormwater Plan 
Checklist (3.02.3.1).  
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